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1. INTRODUCTION

Welcome to NorthEast Monitoring’s HE/LX Analysis Software. Used in conjunction with a NorthEast
Monitoring Holter recorder, HE/LX Analysis allows you to fully review all of the ECG recorded during the

Holter test, including all normal, ventricular, supraventricular, and paced beats.

You can quickly review and edit morphology types, significant arrhythmic events, strips saved for the
printed report, data trends, and tables. You can also review and edit report information before it’s printed,
and then print whatever pages are required to document each patient’s Holter test. In addition, HE/LX
Analysis automatically reads recording data from the recorder’s flashcard - including entries made using

the Event button - and saves sample strips of event markers.

Archiving, Remote Reporting and Spectral Analysis are also included.

Intended Use

The Holter Analysis software is intended to provide Holter analysis (arrhythmia
and trend data) to physicians on their personal computers, on an off-line basis.

Indications for Use

The HE/LX Analysis software is to be used to analyze the data recorded by Holter
recorders such as the NorthEast Monitoring, Inc. DR200/HE and DR400.

1. Detection of Arrhythmias: The Holter Analysis Software assists in the evalua-
tion of ECG recordings of cardiac rhythm when intermittent arrhythmias are
suspected due to patient symptoms such as palpitations, transient ischemic
attacks (TIAs), syncope (fainting), or other such symptoms as determined by
the physician.

2. Efficacy of Treatment: The Holter Analysis Software assists in documenting
the effect of pharmacological treatment of known arrhythmias is effective by
measuring the frequency and duration of the arrhythmia compared to the fre-
quency and duration prior to treatment.

3. Pacemaker Evaluation: The Holter Analysis Software assists in the evaluation
of the function of implanted pacemakers to ensure that the pacemaker is func-
tioning within prescribed limits.

4. The Holter Analysis Software is to be used only on the order of a physician.

Clinical benefits

The Holter Analysis software is used to analyze NorthEast Monitoring Holter
recordings that are used to assist in the diagnosis of heart issues that do not show
up on an electrocardiogram. Holter monitoring is not intended to replace real-time
telemetry monitoring for patients suspected of having life-threatening arrhyth-
mias.

NorthEast Monitoring, Inc. NEMMO027-Rev-S
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Introduction: Software Package includes:

Software Package
includes:

¢ Software-key
e Memory card reader

The HE/LX Analysis software must be
installed on your hard drive to run. The soft-
ware can be found and downloaded from
www.nemon.com under the Support >
Downloads and Documents page. A license
file, provided separately, and the HASP key
must also be installed to run the software. A
demo patient has been provided with your
software. Otherwise, you will need a
flash.dat file from a Holter recorder to begin
analysis.

System requirements

The HE/LX Analysis software is to be used
to analyze the data recorded by a NorthEast
Monitoring Holter recorder. To run the soft-
ware, your personal computer must include:

¢ Microsoft Windows 10 or 11 Operating
System

e aprocessor with a speed of 1 GHz or
faster

¢ atleast 2 GB of memory
¢ atleast 10 GB of free space on hard drive

e a monitor with a resolution of at least
1280 by 1024

e amemory card reader (included) or a lap-
top PC card slot (for DR200)

e alaser printer is recommended.

Operator knowledge

To use HE/LX Analysis software, you must
have extensive Holter knowledge that allows
you to properly identify sinus and paced
rhythms, abnormal rhythms, supraventricu-
lar and ventricular arrhythmias, artifact, ST
segment changes, and pacemaker failures. In
addition, all instructions assume a working

knowledge of computers and, specifically a
Windows operating system.

Software Specifications

User Specifications:

The software is designed to be used by a
trained operator under the supervision of a
licensed clinician for the purpose of evaluat-
ing the severity of arrhythmia as part of the
patient's medical evaluation for treatment.

Performance and Specifications:
Arrhythmia Detection:

e Ventricular Premature Beats (VPBs)

¢ Supraventricular Premature Beats
(SVPBs)

Maximum time analyzed:

¢ A Holter recording up to 14 days

Presentation of data:

¢ (Calibration indication can be provided in
reports

ST Segment slope:

¢ Positive or negative slope indicated based
on manual setting of cursors by trained
operator

LAN Capability:

e Multiple users can access the same
patient data base at the same time

Pacemaker detection:

¢ Displayed and annotated for operator

Reports:
e (Capability of labeling all arrhythmias
with the operators input

¢ Modular with ability for operator to
select modules to be included

NorthEast Monitoring, Inc.
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Introduction: Using a DR200/HE

¢ All reportable values and labels are edit-
able by the operator

¢ Ability to remove and/or add sample ECG
strips.

Using a DR200/HE

The DR200/HE Holter recorder uses a
removable SD flashcard. To input the data
from the recorder to the computer system,
remove the flashcard from the recorder and
insert it into your computer’s card reader.

Depending on your computer and your card
reader, a window may appear acknowledging
that a card has been newly inserted and listing
what files are present on the card. A recording
saved by a NorthEast Monitoring recorder is
named “flash.dat.” If the window appears,
close it.

Initializing a flashcard

Before using a new card for the first time, or
between recordings, you may want to initial-
ize your flashcard with a clean flash.data file.

Using the HE/LX software, select File >
Flashcard > Initialize. If a drive is found, the
Initialize Flashcard window opens.

@ Initialize Flashcard
Dirive Size (MB) Flash found
E\ 129 v]
Fi 1015 v]
@' DR200 / DR300 / DR181
) DR180+
Erase | ‘ Exit

Initialize Flashcard Window

First determine that the correct drive has been
selected for your card. The drive that will be
updated should be highlighted in blue, and if

there is already a flash.dat file on it, the check

box will be populated.

If a drive has not been found, check to be sure
that a card is in the slot and the reader is
attached to the computer. You may need to
Exit and return to this screen to refresh the
Drive list.

Next, check to make sure that the correct card
format option is selected for your recorder and
then press Erase and your card will be initial-
ized for its next use.

Note: If you insert a card into the recorder
and get a message that the “Flashcard is
missing,” the card is not formatted or erased

properly.

Using a DR400

For DR400 recordings, ECG data is saved on
a non-removable flashcard. Use the Copy
flashcard button from the new Patient Infor-
mation window to copy the file. Refer to the
DR400 User Manual for more information on
copying patient files.

Legacy recorders

While they remain in the field, the HE/LX
Analysis Software can be used to analyze
Holter data recorded on NorthEast Monitor-
ing, Inc. legacy recorders such as the North-
East Monitoring, Inc. DR180+, DR181 and
the DR300. The only limitation is that as of
version 6.1 of the software, 12-lead and oxim-
etry features are no longer supported.

NorthEast Monitoring, Inc.
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Introduction: The Holter Procedure

The Holter Procedure

The Holter procedure typically includes the
following steps:

¢ Hook-up the patient using a NorthEast
Holter recorder.

¢ Remove the recorder from the patient,
remove the flashcard from the recorder
and insert the flashcard into the com-
puter’s card reader; or for DR400s,
attach the recorder to the PC.

o Start the HE/LX Analysis software.

¢ (Create a New patient and copy the flash
file to an empty patient directory.

¢ Enter/review the Patient Information.

¢ Click Start to allow software to process
the Holter data.

¢ In Bins, review the Templates for each
morphology (optional)

¢ Review what Critical Events and update
as required.

¢ While reviewing, click “Save” to save
additional strips with significant events
for the final report.

¢ Review the Saved Strips, making sure
that all significant events are docu-
mented and labeled properly.

¢ Create and print the final report to be
reviewed by a physician.

Detailed information about the steps out-
lined above appears in subsequent chapters
in this manual.

Report Serious Incident

The user and/or patient must report any
serious incident that has occurred in rela-
tion to the Holter Monitor should be
reported to North East Monitoring and the
applicable competent authority / govern-
ment agency in the country where the inci-
dent occurred.

Online help

In addition to the information in this man-
ual and the on-screen help messages that
appear within the HE/LX Analysis soft-
ware, more information and help is avail-
able at our web site www.nemon.com or

» Toll Free in USA: 866-346-5837
e Phone: [+1] 978-461-3992

e Fax:[+1]978-461-5991

e email: support@nemon.com

e The “Support” page on the web-site
includes software downloads and user
guides.

NorthEast Monitoring, Inc.
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2. PATIENT
INFORMATION

The HE/LX Analysis software automatically retrieves the Holter signal, patient identification number,
recorder number, date and time the recording started, and any events that the patient saved using the
EVENT button on the recorder. All of this information is carried forward onto the Patient Information
screen when the flashcard is read. You then, may enter any additional data that you want to save on the
Patient Information screen.

While running the HE/LX Analysis software, you have the choice of
opening the Patient Information window for (1) the last patient whose
Holter test was accessed (that is, the “current” patient), (2) a previous
patient whose Holter test has already been analyzed, or (3) a new patient
whose Holter test has not yet been analyzed. In the first two cases, a
patient record has already been created for the patient and the Holter data
for the patient has already been downloaded from the flashcard onto the
hard drive of your computer.

The software has two toolbars that allow you to switch between views for
the patient that is currently opened. In this example, “Demo Patient” is the
patient who is currently open and whose data you are able to view.

@ HE/LX Analysis: Demo Patient (C:nmb0b\patidemac)
Eile Review HRY Settings Help

Bin Critical BEvents Sawved Strips Page Trends Tables Reports
Standard Holter toolbars

In the case of a new patient, a new Patient Information record must be
created and the Holter information downloaded from the flashcard. This
chapter covers creating a new patient record first.

To enter information about a new patient’s Holter recording, the HE/LX
Analysis software must be running. When the program appears, it dis-
plays a blank screen with the standard toolbars.

NorthEast Monitoring, Inc. NEMMO027-Rev-S Page 10 of 99
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Patient Information: Enter a new patient

File

Revieww HRV Settings Help

Open/New Cri-0
Patient Information Fz
Preview Flashcard

d Strips Page Trends Tahles Reporis

Scan

Full screen

Center| Les

Preferences
Initialize Flashcard

Exit

File drop-down options

Enter a new patient

To create a new patient, do the following:

1. Insert the patient’s flashcard into the
card reader or plug DR400 into PC, and
click File > Open/New from the toolbar.
The Patient List will now appear.

2. From the Patient List, select an empty
directory (row) and double-click on it
or click the New button at the bottom
of the window.

3. A Patient Information window will
open, and click on the Copy Flashcard
or Start button to read the flashcard.

4. Now press the Start button for analysis
to begin.

Some things to be aware of:

¢ If you press the Copy Flashcard or the
Start button before inserting a card,
you will see a window that explains
that there is no flashcard in the drive. If
this happens, insert the flashcard into
the drive and click Retry.

e If you see a window that shows that
more than one flash.dat file has been
found, you will need to determine
which file to use before creating your
new patient. Once you determine
which is correct, click on and highlight

AN s a1

0 se

the file that you want to use at this

time.

EA rultiple Flash Four x|
_Card size DCrive ) Flash size |
970 MB  |IMlash.dat |30 MB
122 MB  |L'lash.dat |24 MB

| Cancel
Multiple Flash found

If you are not sure which file to use, you
can use File > Preview Flashcard to see
recording information about the file that
was saved on each card. More information
on Preview Flashcard can be found at the
end of this chapter.

Patient Information window

As the Holter data from the card loads onto
your computer hard drive, you can enter
the patient information. Hover your cursor
over the title of a field to get more infor-
mation, when available.

Note: Once the flash.dat has loaded, the
“Copy flashcard” button in the Patient
Information window changes to “Copy
different flashcard.” If the ID from the
recorder does not match the patient,
remove the card, insert the correct one
and click “Copy different flashcard.”

NorthEast Monitoring, Inc.
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Patient Information: Enter a new patient

]

Last name, First, MI | || | indication
Gender @mm  OF <o | [
D.O.B. [MWDDNYYY | | [rears [=] | =
| =
LD. [225621543 |
Scan# [2022-08-10 13:55 | |~EEEET
| =
Hookup techianalyst | || | | |
-
Type of Analysis/Report |Custom |v | | | -
Physician | |M
Interpreting physician | |M
otes | T — o —
Recorder Model |
|Copy different flashcard |
Channels Recorded | |
Patient copied (remove flashcard)
Date recorded [07/08/2010 | [11:12am
Recorder/Validation # (03854 0050
T

New Patient Information window

DOB and Age

The D.O.B. and Age fields work together. If
you know the patient’s date of birth, enter it,
and the software automatically calculates the
patient’s age based on the D.O.B. and the
recording date. If you do not know the date of
birth, but know the age, type a numeric entry in
the Age field, and select the appropriate unit
(e.g., years) in the Age Unit field.

Type of Analysis/Report

Custom

Custom
Default Holter

Your system has
been set up with a
Default Holter con-
figuration or Type
of Analysis/Reports
to get you started.

The Custom configuration is identical to the
Holter configuration, except that it includes the
Report header that you entered in the Setup
screen, although it is editable, if you so choose.

The Type selected will load a set of default set-
tings for the patient. Once assigned, you can

override any of the settings by clicking on Set-
tings and updating where you choose. After you

save a patient with one type of analysis / report,
you can change it, but all data that you edited,
except for patient information, will be lost.

Note: For more information about Types of
Analysis/Report, see Chapter 9: Configura-
tions.

Notes

The Notes field allows an alphanumeric entry
that can be used to record information that
might be helpful about the Holter test or the
patient. Notes are not printed on the final
report.

Recorder Model and Channels
Recorded
User can enter the information from the record-

ing. If always the same, these values can be set
up in a configuration for ease of entry.

BMI

HE/LX Analysis will calculate your patient’s
Body Mass Index (BMI) if you enter the
patient’s height and weight and the appropriate

NorthEast Monitoring, Inc.
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Patient Information: Diary Information

units. A patient’s weight status can be
determined from the BMI as follows:

¢ Below 18.5 - Underweight
e 18.5-24.9 - Normal

e 25-29.9 - Overweight

¢ 30 & Above - Obese

Height |50 in -
Weight [120 | [lbs [w| BME [234

BMI on Patient Information Screen

Diary Information

While wearing a NorthEast Monitoring
Holter recorder, a patient can identify
symptoms and activities in two ways:

(1) by pressing the Event/Diary button on
the recorder and, possibly, entering a pre-
coded symptom or activity, or

(2) by keeping a written record of times
and symptoms or activities.

When analysis takes place, the software
reads the Event/Diary button information
directly from the flashcard and enters it
automatically. You must type any signifi-
cant information from the written record
manually into the Diary window from the
Patient Information Screen.

To open the Diary Symptoms window,
click the Diary button in the Patient Infor-
mation window. If any entries are present
initially, those are the diary entries that
were automatically read from the flash-
card. You can now add any additional
diary entries at this time.

Date -. The date and time will initially be
populated by the previous entry or the date
recorded. If you need to edit the date, you
can either do it manually by clicking on it
or double-click on it to open the calendar
edit screen

Time -. You should edit the time by dou-

ble-clicking on the box. Since no two diary
entries can contain the same date/time, be

sure that you edit the time so that is not the
same as what is entered above or below it.
If two entries appear at the same date/time,
you can edit the symptom to include both.

Symptom -. To enter a symptom, first
click on the Symptom field next to the
Date. Then enter the text either by typing a
freeform entry or by clicking on the arrow
to display a scrolling list of pre-typed
entries. To enter a selection from the list,
click on it; you can now edit the entry or
move to the next field by clicking on it.
Once a symptom is entered, the diary entry
now exists. If there is no symptom, the
diary entry does not exist.

When you have finished entering all writ-
ten diary events, click the OK button to
save your entries and return to the Patient
Information window.

Delete -. To delete a diary entry, click on
the trash can icon to the left of entry.

Date Time Symptom

08/18/2007 11:00 PM Chest pressure

09/19/2007 10:00 AM |

Note: Whether the software uses a 12- or
24-hour clock is determined by your
computer’s setting in the Control Panel.

Bathroom

Chest pain

Chest pressure
Dizzy

Diriving

Exercise

Lying down %
Medications

4]

Dairy symptoms window

NorthEast Monitoring, Inc.
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Patient Information: To Change Settings

Editing -. If you add or modify diaries after
analysis, the system will force an update and
some of your editing of the ECG may be
lost. For this reason, it is best to enter diaries
before the analysis is started.

To Change Settings

During Holter analysis, the HE/LX Analysis
software makes decisions about the Holter
signal based on a variety of predefined set-
tings from the Type of Analysis/Report or
Configuration you have chosen for your
patient. After selecting a configuration, you
can change any of the analysis criteria in the
Settings windows, which are accessible
from the menu displayed by clicking the
Settings button in the Patient Information
window or by clicking the Settings menu
item in the main toolbar.

Adjustments that can be made in the Set-
tings windows are detailed in Chapter 3:
Holter Analysis.

Starting Analysis

To start analysis after
entering patient data,
click the Start button at
the bottom of the
Patient Information window. The Analysis
window may appear or you may see Analy-
sis in the lower left-side of the screen. You
cannot stop or cancel the initial analysis, and
once analysis is complete, the Patient Infor-
mation will be changed.

Start

The Current Patient

At any one time, only one patient is the cur-
rent patient - the patient whose information
appears at the top of the screen,

@ LX Analysis: White, Stanley (Cinm'pat\2)

the patient you see when you select File >
Patient Information, the patient whose ECG
appears in the screen displays, the patient
whose report prints when you make the
request. To change the current patient to a
different one, either click on the appropriate
name on the Patient List and click Open, or
double-click on the appropriate line.

Also, you can change the current patient
using the << and >> buttons in the bottom of
the Holter LX window. << changes the cur-
rent patient to the previous one on the
Patient List and >> changes the current
patient to the next one on the Patient List.
Click each button repeatedly to move back-
ward or forward through the list. To display
a combo box listing all patients on the sys-
tem, click the arrow to the left of the << and
>> buttons.

NorthEast Monitoring, Inc.
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Patient Information: Edit patient information for the “current” patient

Patient Information x
Last name, First, M [Dlivia | [smith | [E | [ndication
Gender @ F 0 |F'n\,r5|cal exam | .
D.OB. [01/02/1953 | [s7__| [rears [~] | I
-
LD. [123456739 | | |U
Scan# [2020-03-04 09:23 | [Medication
Hookup tech/analyst [Henrietia | [Arthur | |Asp|r|n | =
Type of Analysis/Report [Custom [~] I I :
Physician |Robert Suarez |m
Interpreting physician |Maria Ot |M etant |B4 ! |in. |'|
Notes [routine | -2 | [ [»] Bm# [0 |
Recorder Model [DR400 |
Channels Recorded ’E
Date recorded  [02/27/2020 | [04:42pm
RecorderiValidation # 104164 0020
| Diary | | Settings | | Re-analyze | I oK | | Cancel

Current Patient Information after analysis

Edit patient information
for the “current” patient

Once analysis is complete for a patient’s
Holter data, you can reopen the Patient
Information window and edit the informa-
tion. To open the Patient Information win-
dow, select File > Patient Information.

To save your data and close the Patient
Information window without starting anal-
ysis, click OK. To close it without saving
any changes, click Cancel.

While most of the Patient Information win-

dow is the same as when new, there are
significant differences:

¢ The Re-analyze button replaces the
Start button because the Holter signal
has already been analyzed. (See Chap-
ter 3: Holter Analysis, for information
about using the Re-analyze button.)
If you choose to change the Type of
Analysis/Report at this time, you will

be forced to redo analysis and all edited

ECG data will be lost.

¢ The absence of the Copy different
flashcard button.

NorthEast Monitoring, Inc.

NEMMO027-Rev-S Page 15 0f 99




HE/LX Analysis Operator’s Manual

Patient Information: The Patient List

[A) Patient Lis (%]
Search Patients
Mo. Mame D.0B. Recorder# | Date recorded Analyzed Length P E v L A Opened by
1 L] L] L L] L -
2|Sample SVT 5.43 120003 09/07/2007 03/29/2016 2401 U U Ll ] L] =|
3| 14-day new dll 016598 1210512013 03162016 33358 U] ] Ll ] vl
4|14-day onx 015403 0712512013 03N6/2016 310:09 L] L] L] L] L]
5|TESTO1 English set 007277 071312010 030712016 2359 U U Ll ] v]
B{TESTO1 French set 007277 071312010 030712016 2359 U] ] Ll ] vl
7|DR181 30363 0819/2012 11192014 2356 L] L] L] L] lv]
8S\T 120003 09/07/2007 0312812016 2401 U U Ll ] v]
9 L L L L L
10 L] L L] L] L]
11|Crabdac1, Sleep 264959 0100712007 04/07/2016 819 U U L ] L]
12|14-day new dll 016598 1210512013 03H6/2016 33358 L] L] [ [] v
13(14-day new dll 016598 1210512013 03N6/2016 33358 L] L] L] L] l¥] |
1dlpaced. |think 329374 07/06/2009 032912016 1116 [] [] [l [ [ b
‘ Archive H Remote Receive ‘ ‘ Send Report Remote H HIS Export ‘ ‘ Delete H Hew H Open H Cancel

An example of the Patient List window

The Patient List

All of the patients saved in the software
appear in the Patient List. Select File >
Open/New from the toolbar to view.

From the Patient List you can choose to open
a patient’s record by clicking and highlight-
ing it and pressing “OK” or by double-click-
ing anywhere on the patient line.

From the Patient List, you also can create a
new patient by clicking on an empty direc-
tory (row) and clicking the New button at the
bottom of the screen. The New button is only
available when a directory is empty.

On the Patient List, if you don’t know the
meaning of a specific column, you can hover
your cursor over the heading for that column
and help will be displayed if it exists.

Length h| E P
20:01 Wy [] ~I
2004 | Time analyzed by the software

AC- 4N | = | =
Hover for Help on Patient List window

Customize the Patient List View

You can customize the Patient List for your
specific needs in the following ways:

¢ To change what col- ¥ No.
umns appear on the list, Directory
right-click on the top ¥ Name
row of the column
‘ ) ¥ D.OB.
headings. You will now
¥ 1D

see a list where you can
check or uncheck items
to include or exclude from the list.

M Tune nf Analuei

¢ Once you have decided |

what columns you want to
see, you can change the ;53
position of the column by |g353
clicking on it and drag-  iggp
ging it to a new location.

e QGrab the column divider _

to increase or decrease the g
size of any column. -Ldlpaﬂ ] m
IdipatiZ  |Smith, |

s e Sort on
LEﬂgth any column by double-

clicking on the header for
say T t
29:01

NorthEast Monitoring, Inc. NEMMO027-Rev-S
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Patient Information: Preview data

that column. An arrow will appear to
show you which column is sorted.

Search Patients

The Search Patients box will search all visi-
ble columns for a match, and only show
patients who meet the search criteria.

Archive button

The Archive button at the bottom of the
screen will take you to the Archive screen
where you can select one or more patients to
save in the Archive directory. You can also
copy previously deleted records using the
Restore tab. More information is provided
later in this manual.

Remote Receive button

If the Plugin is installed, the HE/LX Analy-
sis software is able to receive files from the
LX Remote web-based system.

Send Report Remote button

The NARP program must be running on
your computer for this to work, and the
Remote User must be running LX Remote to
receive the report.  When you select a
patient with a report, this button will be
enabled.

Select Remote User to Send Report for Patient. Simulztor

remote
Cancel

HIS Export button

If a patient has a PDF report and you see this
button, you are able to export records for
your Hospital Information System (HIS).

This is done by selecting a patient and press-
ing the HIS Export button.

By doing this a record and the final report
will be written to the directory
c:\HIS_Transfer.

Delete button

This will allow you to delete one or more
patients. This data will be lost forever unless
saved elsewhere or Archived.

New button

When you select an empty patient directory,
this button is enabled.

Open button

Enables you to open a different patient than
is currently opened.

Preview data

If you would like to review the clerical infor-
mation on a flashcard or recorder before cre-
ating a new patient record, you can insert the
card into the drive and then select File > Pre-
view from the main toolbar. This opens the
Preview window, which displays the patient
ID, Date and time recording was started and
Recorder# off the inserted flash.dat file on
the card or recorder. Data is not loaded onto
your computer’s hard drive.

[ Ed
LD. 20000
Date recorded |12/08/2009 12:14pm
Recorder# (0000328839
Research | | OK |

After verifying that the file is correct, click
OK to close the window, select File > Open/
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Q Remote Receive ==
TP Directory |MN:\nm\ftp\haolter || Browse | Search
Search Mo.| ID# | Mame| Analyzed| Length P L [HIS| A |Op..
16[2 Sam... |05/01/2... |20:08 v -
Date Recor...| D% Patient Mame File Remote User 171234 _|amnealoizTe 740 =IE—BN=BE—
016-12-14 .. |25178 |300BAT | holter nemon_251... DR300 Holter = 181185 ; Enha._ |0a/22/2_ |23.59 —EAE—RE—EE—= =
016-11-30 ... [20765 [300H holter nemon_207...[DR300 Holter | Copy | Tol6300 “osn1z. la 18 T e i e —
017-04-06 ... [26559 (01271 holter nemon_265... DR300 Holter i 20 —T= T e
016-12-06 ... (20738 |233 holter nemon_207...[DR300 Holter 5138702 |[14-D_ [0514/2_ |23.59 mEEmEEmEEFA
017-09-25 ... [26659 |0310 holter nemon_265... DR300 Holter | 4 2236969 calibl.'" DSJ"MJEm 71:15 =l
017-09-11 ... 026559 |01234 test 4.45 remotel1-hol...remote 53 g =TT T T
017-09-07 ... [2665659 |0300 holter nemon_265... DR300 Holter — 240 holter |04/26/2... [1-:44 mEE=EE R |
n4 NA40 N2RERQINI2RTO afaatr ramntadhnl ramntad S - = — === — St

FTP delete

Remote Receive window

New and follow the normal process to cre-
ate a new patient.

If the information in the Preview window
does not match the information you have,
do not proceed without clearing up the dis-
crepancy.

Remote Receive

The HE/LX Analysis software is able to
receive files from the LX Remote web-
based system.

Note: Please ask your technical profes-
sional for assistance in setting this up.
Refer to Chapter 10 for information on
setting up Remote Receive.

If enabled, there
is a window at
the bottom of the
screen that tells
you whether remote files are available, or
if your remote process is not running.

Remote - 11 file(s)

Remote Receive Screen

Use Remote Receive to receive and import
flash.dat files sent from other facilities. In
order to enter patient files into HE/LX
Analysis that you receive remotely, you
will need to go to File > Open/New and

press the Remote Receive button at the

bottom of the Patient List window. You
will now see the Remote Receive patient

window.

The Remote Receive window has two
sides. On the left, is a list all of the patients
who are received remotely and currently
exist in the FTP directory. If your remotely
received patient files are in another direc-
tory, use Browse to find your records.

On the right, is a copy of your Patient List
and shows your where you have open
directories for placing your remote

records.

You can copy a patient file onto your desk-
top by doing the following:

1. Select a single record from the Remote/
left-side of the screen.

2.

Select an empty directory on the right-

side of the screen. Both should now be

highlighted and the Copy button

should now be available.
3. Press the Copy button in the middle of

the screen. The patient should now be

copied to the Patient List on the left.

Close the screen and you will return to

the Patient List where you can begin
analysis on your new patients.

Other buttons on the screen are:
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e The FTP delete button is used to delete
FTP records that you do not want to copy
to your desktop.

¢ The Delete button is used to delete patient
records from the desktop. Only do this if
the patient has already been archived or
you no longer need this patient informa-
tion.

¢ The OK button will return you to the pre-
vious screen.

As with the Patient List, both sides of the
screen can be customized for what columns
appear, column width and column order.
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3. HOLTER ANALYSIS

This chapter addresses the features that you have control over during analysis, re-analysis and updating.
During analysis, the HE/LX Analysis software detects each R-wave; determines the patient’s normal mor-
phology; establishes normal, ventricular and paced templates; matches every beat to a template; counts
normal, supraventricular, ventricular and paced beats, including any pairs and runs; measures RR intervals
and calculates heart rates; does ST segment and AF analysis; counts other abnormalities as defined in the
Scanning Criteria; and saves sample strips for the final report. You can review and edit decisions made by
the software; the information is then either re-analyzed or updated to include your changes.

Starting Holter Analysis

After entering patient information, :
click the green Start button at the bot-
tom of the Patient Information win-
dow to start Holter analysis. The

Analysis window appears. When anal- | Flapsed |00:00:00
ysis is complete, the Analysis window T
closes automatically.

Time  |00:00:00-1

Cinmipatidemoidatacard. dat

Status | Proc [Doris Johnson] at 07:40:19 2002-05-0¢

To interrupt analysis, click the Stop

button. The analysis ends immedi- Stop
ately, with data only for the portion
that was analyzed by the time of the Analysis window

interruption. The unanalyzed ECG can
be reviewed in Page and printed in full disclosure.

All data must be reviewed carefully to ensure that you agree with the beat labels the
software has selected; if you do not agree, you can change them and their color will
change appropriately. To begin, you will want to fine tune the results by changing
the Scanning Criteria, once that is set as you like, you will then be able to edit indi-
vidual or groups of beats as discussed in the next Chapter - Review Methods.

Color coded beat morphologies
Throughout the HE/LX Analysis software, the ECG is color-coded based on how
the system has labeled each beat morphology:

¢ Light blue (cyan): Signal that appears to be contaminated by artifact.

¢ Red: Beats identified as ventricular premature beats (VPBs). They differ signif-
icantly from the normal; they are not necessarily premature.

¢ Green: Beats the software has identified as normal.

¢ Yellow: Beats identified as supraventricular premature beats (SVPBs). They
have a normal morphology, but fall early.
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e Orange: Beats identified as part of an AF
event.

e Cobalt blue: Beats identified as paced.

¢ White: Beats identified as pauses, based on
the definition in the Scanning Criteria win-
dow. The white overrides any other color that
the beat may also qualify for (e.g., red
because it’s a VPB).

In addition to the labels the software can provide
for each beat, there are some labels only you can
use to relabel beats. These are:

* Questionable (Unknown): Use this label to
separate out beats you cannot identify and
keep them from being included in another
category. They are colored green, like nor-
mals. This can be used as a template or a beat
label.

e T-wave: Use this label if the software has
identified a portion of the signal as a QRS, but
it is not. This will remove the beat from the
counts and will merge its RR interval with the
preceding RR interval. The signal will take the
color of whatever beat precedes it. This can
only be a beat label.

Beat Labeling

Once the beat morphologies are established,
arrhythmia analysis starts by labeling each beat.
The beat labels that are automatically assigned
by the analysis process are assigned in the fol-
lowing order:

1. Event - the time-of-day when either (1) the
event button was pushed or (2) an entry was
manually typed into the Diary Symptoms
window

2. Artifact - ECG Signal that appears to be
contaminated by artifact

3. VTAC - three or more VPBs in a row,
regardless of heart rate

4. Failure to Sense - the occurrence of a paced

beat too soon following another beat; that
18, too short an RR interval

5. Failure to Capture- the presence of a pace-
maker spike without a following R-wave
6. Inhibition - the absence of a paced beat
when it should occur; that is, too long an
RR interval
7. VPB Pair - two VPBs in a row
8. Bigeminy - an alternating pattern of single
VPBs and normal beats, with at least three
VPBs in the series; that is -
NVNVNVN
9. Trigeminy - a pattern of single VPBs every
third beat, with normals in between, with at
least three VPBs in the series; that is -
VNNVNNVN
10. Quadrigeminy - a pattern of single VPBs
every fourth beat, with normals in
between, with at least three VPBs in the
series; that is - VNNNVNNNVN
11. VPB- a single beat that matches a ventric-
ular template, regardless of prematurity
12. SVT - three or more SVPBs in a row, the
first 3 beats must meet the SVT Heart rate
13. SVPB Pair - two SVPBs in a row that
meet the SVT Heart rate
14. SVPB- a beat that matches a normal tem-
plate, but occurs at least as early as the
SVPB prematurity setting in the Scanning
Criteria window
15. Missed beat
16. PAT (paroxysmal atrial tachycardia) - a
sudden rate increase, 2x the normal rate,
stable before and stable after
17. Tachycardia - a heart rate at least as fast as
the Tachycardia setting in the Scanning
Criteria window
18. Bradycardia - a heart rate at or below the
Bradycardia setting in the Scanning Crite-
ria window
19. Unknown or Questionable
20. AF (Event) - AF consists of Atrial Fibrilla-
tion and/or Atrial Flutter. To be labeled as
AF, beats must meet both Minimum AF
Peak HR and Minimum AF Time require-
ments in the Scanning Criteria. VPB and
artifact beats can occur within an AF event.
VPB and artifact that falls within an AF
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event, will be included in the AF time, but
the beats will not be counted as AF beats,

Tachycardia defines at least how fast a
heart rate must be for the Tachycardia label

but as VPB or artifact, respectively.
21. Irregular HR (Sinus Arrhythmia) - a
variability in sequential R-R interval

22. AV Paced — both atrial and ventricular

23. A. Paced — Atrial only
24. V. Paced — Ventricular only
25. Normal - None of the above

Scanning Criteria

The Scanning Criteria are used during Holter

analysis to define some of the arrhythmias
labeled by the software, along with settings
that control the amount of information pro-
cessed.

The adjustable criteria include:

[

to appear. All beats that occur at that heart
rate or above are included in the tachycardia
beat count in the Tachy/Brady table in the
Tables window.

¢ Bradycardia defines how low the heart rate
must be for the Bradycardia label to appear.
All beats that occur at that heart rate or
below are included in the bradycardia beat
count in the Tachy/Brady table in the Tables
window.

¢ SVPB Minimum Rate is the minimum
heart rate required for a beat to be labeled
SVPB. If not listed in Scanning Criteria, 75
bpm is used. Reanalysis required if changed.

¢ VTAC Table Rate separates fast and slow
runs of VPBs that appear in the Ventricular
Runs table of the Tables window and in the

Heart rates
Tachycardia

Bradycardia
SVPB Minimum Rate
VTAC Table Rate

Pause length

N
o
=1

Processing modes
[ ] Narrow QRS
Artifact filter

Processing criteria
Signal quality

Excellent

Number of channels processed

i

Primary channel

[y

Alternate channel

[sa

Automatic channel selection

Report

Interval size (min.) (G0
Analysis duration |[024:00

Extra dead-time |J.06
SVPB prematurity M

Pacemaker criteria

Scanning Criteria window in Settings menu

Automatic ST Marker selection Pacemaker type |Not paced [=]
Process ST events Minimum heart rate |40
[] Label Events as Artifact Maximum heart rate W
[ ] Disable SVPB counts Maximum vent. spike to Rinterval [150 |
Minimum AF Peak HR |75 Maximum atrial spike to R interval 300
Minimum AF Time (secs.) |15 | Paced beat and the beat after can be called a SVPB
Lead Labels Channel 4 IFEI
Channel2 [chz [«]
Channel 3 IFEI
I OK | | Cancel
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Report Summary. In all other areas of the soft-
ware, slow and fast ventricular runs are com-
bined in the VTAC counts.

Pause length (sec.) defines how long an RR
interval must be for the beat at its onset to be
called a Pause and appear white on the colored
display. This RR interval can be initiated by
any type of beat except artifact.

nel is used first to locate R-waves, but if an R-
wave cannot be located, the software refers to
the alternate channel to locate the beat, if one

is present.

Alternate channel is used only in two-chan-
nel processing. It determines which channel is
used in case an R-wave is not found in the pri-
mary channel, and it controls which channel is
used as a second channel for template-match-

Processing Criteria will all require reanalysis ing.
if updated: ¢ Automatic channel selection allows the soft-

* Signal quality has three settings that control ware to switch primary and alternate channels

the amount of artifact that is tolerated before

the signal is thrown out because of too much

artifact:

1.Research turns off the artifact detector so
that none of the signal except the first minute
and the last minute of the recording is called
artifact. This results in the analysis of all the
signal, including any artifact.

2. Excellent allows the software to detect and
reject a moderate amount of artifact. Any
signal that is determined to be contaminated
with artifact appears light blue and is not
analyzed. Anything that occurs during peri-
ods of artifact is not counted.

3. Normal allows the software to discard any
signal that it considers contaminated by arti-
fact. Anything that occurs during periods of
artifact is not counted.

Number of channels processed determines
whether the software uses one or two channels
to determine the location of an R-wave and
what template each matches. Single-channel
analysis uses just the channel set in the Pri-
mary channel field. Dual-channel analysis
uses the Primary channel to locate R-waves
first, then refers to the Alternate channel as a
back-up channel to locate R-waves, and both
primary and alternate to do template-match-
ing.

Primary channel determines which channel
is used during analysis. For single-channel
analysis, the primary one is the only one used
to locate R-waves and do template-matching.
For dual-channel analysis, the primary chan-

if it determines that signal has been lost in the
primary channel. Turn this off to force the
software to use a particular primary or alter-
nate channel. If you change the Number of
channels processed field to 1, this setting is
turned off automatically.

Automatic ST Marker selection allows the
software to detect the j-point and set up the ST
markers appropriately. If you manually
change the ST marker locations in the Calibra-
tion window, this setting will turn off automat-
ically.

Process ST events lets you turn ST segment
analysis on or off, depending on your prefer-
ence.

Label events as artifact lets you to include or
exclude events from the recorder from being
labeled as artifact. Sometimes events are inap-
propriately labeled as arrhythmia because of
the calibration mark that is saved at the time
the button is pressed.

Disable SVPB Counts prevents the system
from label beats as SVPBs. SVPB beats can
be labeled manually.

Minimum AF Peak HR is the minimum HR
which at least any 2 beats of the previous 20
must reach. AF includes both Atrial Fibrilla-
tion and Atrial flutter. Valid entries are 30-
250. Enter 0 in this field to turn both Irreg-
ular RR and AF Off. For this to occur, Min-
imum AF Seconds must also be set to zero.

Minimum AF Time in Seconds is the mini-
mum amount of time In seconds required to
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label irregular HR as AF. AF can consist
of both Atrial Fibrillation and Atrial
Flutter. Valid entries are 15-300 sec-
onds. Enter 0 in this field to turn AF
Off.

Lead Labels allows you to change the
label for each channel. You can also
enter a label of your own by typing in a
new entry.

Narrow QRS permits the software to
identify narrower-than-normal QRS
complexes, like those seen in pediatric
patients, as normal beats. Turn this on
routinely for pediatric patients.

Artifact filter works in conjunction
with the Signal quality setting. If it is
turned on and Signal quality is set to
Normal, the filter limits the response to
20 Hz, instead of 70. If it is on and the
Signal quality is set to Excellent or
Research, the filter limits the response to
30 Hz instead of 70.

Interval size (min.) determines how
many minutes are including in each
interval in the interval tables of the
Tables window.

Analysis duration determines how
many hours of data are analyzed. All the
ECG loads in from the memory/flash-
card during analysis, but analysis stops
after the amount of time indicated here.
It uses the HHH:MM format, with the
first three digits indicating how many
hours and the second two indicating
how many minutes. A maximum of 336
hours (14 days) may be entered.

Extra dead-time controls the tail end of
the dead-time period following an R-
wave during which another QRS com-
plex cannot be detected, allowing for the
presence of a T-wave. Increase the time
(in seconds) if large T-waves are being
identified as R-waves. See details in
Appendix A.

¢ SVPB prematurity (percent) sets the
requirement for how early a beat that
matches a normal template must be for it
to be identified as an SVPB. For exam-
ple, at a heart rate of 60 bpm, a normal
RR interval is 1 second long, and a beat
that is 10 percent premature would fall
at 0.9 seconds after the preceding beat.
The SVPB Minimum Heart Rate must
also be met.

¢ Pacemaker type contains four settings
that allow the software to expect certain
behavior:

1.Not paced means that the software
will not identify any pacemaker
spikes, beats or failures.

2. VVI means that each paced beat will
be preceded by a single spike. All
paced beats are counted as ventricular
paced.

3. AV sequential means that paced beats
will be preceded by two pacemaker
spikes, one atrial and one ventricular.
All paced beats are counted as AV
paced.

4. DDD means that paced beats can be
preceded by either one or two pace-
maker spikes. Depending on the
spike’s location relative to the follow-
ing R-wave, a beat preceded by a sin-
gle spike can be called either atrial
paced or ventricular paced, while a
beat preceded by two spikes can be
counted as AV paced.

e Minimum heart rate refers to the mini-
mum rate allowed by the pacemaker. If
the pacemaker does not fire appropri-
ately and there is an RR interval longer
than the patient should experience, the
Inhibition label appears.

e Maximum heart rate refers to the max-
imum rate initiated by the pacemaker. If
the pacemaker fires early, typically
because it did not sense the previous
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beat, it would result in a faster rate, the
Sense failure label appears.

¢ Maximum vent. spike to R interval
sets the maximum time between the fir-
ing of the second pacemaker spike and
the following R-wave. If the second
spike appears and is not followed by an
R-wave in this amount of time, the Cap-
ture failure label appears.

e Maximum atrial spike to R interval
sets the limit for how long is allowed
between a single spike and the subse-
quent R-wave. If a single spike occurs
and the following R-wave is not within
this amount of time, the Capture failure
label appears.

e Paced beat and the beat after can be
called a SVPB is a setting that allows
you to identify early beats following a
paced beat as SVPBs because they are
premature.

Note: Refer to the section “Pacemaker
analysis” in this chapter for more infor-
mation about the pacemaker settings.

Reanalysis

If you have already analyzed the patient’s
Holter, changes that you make to many of
the settings will force the software to re-
analyze the patient’s data. When re-analy-
sis takes place, the patient will be newly
analyzed and all editing changes you have
made previously will be lost.

Re-analysis is required after changing any
of the settings in the Processing criteria,
Pacemaker criteria and Processing modes.
Additionally, Analysis duration, Extra
dead-time SVPB Prematurity and SVPB
Minimum Heart Rate settings require
reanalysis.

After changing settings and clicking OK to
save, the software asks you to confirm that

you want to reanalyze or not. If you want
the change to take effect, click Yes. If not,
click No, and your changes will not be
saved.

Update

Some changes in the Settings require an
update afterward. The update incorporates
simple changes into all other aspects of the
report. For example, a change in all
matches to a beat with 12 matches from
ventricular to aberrant will affect other
aspects of the report: the total count of
VPBs will decrease by 12 and SVPBs will
increase by 12 in Tables, Critical Events,
Trends, and Report Summary. In addition,
different Saved Strips will be selected.

Those changes in Settings that require an
update are all those in the What Strips to
Auto Save and How Often Strips Auto
Save windows, along with these settings in
the Scanning Criteria window - Tachycar-
dia, Bradycardia, VTAC rates, Pause
length and Interval size.

If the “Automatically Update feature” is
turned on in the Preferences window, the
update will occur automatically when you
close the Settings window or go to any
other window while using the software.

If the Auto-
—

matic Update
Lead |Ehan1 w | Gg tuned offin

feature is

the Prefer-
ences win-
dow, that
means that after some editing changes, you
must click the Update button to incorpo-
rate your changes. After you make changes
that require an update, the Update button
will become enabled and will blink red as a
reminder that you must at some point click
it.

Update required
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¢ Bigeminy

What Strips to Auto

Save

All the different types of strip labels the
software uses appear in this window. The
software uses these labels to identify one
particular beat or event (for example, the
“current” beat or the beat centered in a
Saved Strip). Each label can be turned off
or on to indicate whether sample strips of
that type should be saved for the final
report. A check mark indicates that sample
strips with that label will be saved.

¢ Trigeminy

¢ Quadrigeminy

e Longest VTAC - the longest run of
three or more VPBs, regardless of rate

¢ Fastest VTAC - the run of three or
more VPBs with the fastest heart rate

Pacemaker Analysis - For more informa-
tion, refer to the section ‘“Pacemaker Anal-
ysis” in this chapter.

¢ Failure to capture - Pacemaker only

Click on a label or its check box to turn it * Failure to sense - Pacemaker only

off or on. Click on the button Select/Dese-
lect All to turn all labels on or off. Click
OK to save changes.

The strip labels in the What Strips to Auto
Save window are as follows:

e VPB

e VPB pair

e VTAC

e Inhibition - Pacemaker only

 SVPB
¢ SVPB pair
* SVT

¢ Longest SVT - the longest run of three
or more SVPBs, regardless of rate

e Fastest SVT - the run of three or more
SVPBs with the fastest heart rate

.

What Strips to Auto Save

VPB SVPB

VPB pair SVPB pair
VTAC SVT
Bigeminy Longest SVT

Trigeminy Fastest SVT

Quadrigeminy ST Events
Longest VTAC
Fastest VTAC

Failure to capture

Depression
Elevation
Baseline
Onset
Maximum HR

Failure to sense
Inhibition
Maximum deviation

End

AF

Longest AF
Fastest AF
Pause
Tachycardia
Bradycardia
Irregular RR
Minimum HR
Maximum HR
Shortest RR
Longest RR
Diary or event
[] save 1 strip/hour
[] calibration strip

selectiDeselect All | |

What Strips to Auto Save window in Settings menu

ST Segment
Analysis - For
more information
on ST Analysis,
refer to the sec-
tion “ST Segment
Analysis” in this
chapter. T he
Depression and
Elevation check-
boxes are NOT
strip labels.
Instead, they
determine whether
strips of the fol-
lowing types are
saved for each epi-
sode of ST
Depression or Ele-
vation detected by
the software.
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e Depression - at least a 1 millimeter depres- e Diary or event
sion in the ST segment compared to the e Save 1 strip/hour - a strip at the onset of
patient’s normal each new hour

* Elevation - at least a 1 millimeter elevation o Calibration strip - the calibration signal at
in the ST segment compared to the patient’s the onset of the Holter recording
normal

e Baseline - a sample of the patient’s normal
ST segment preceding a detected event

¢ Onset - near the beginning of a detected
event, at the time the change is 0.5 mm.

¢ Maximum HR - the ECG when the maxi-
mum heart rate occurred during the event

e Maximum deviation - the ECG at the
point of maximum change from the normal

e End - the ECG after the patient has re-
established normal

More options:

* AF - AF events
* Longest AF - the longest period of AF

e Fastest AF - the fastest period of AF based
on AF HR

e Pause - an RR interval at least as long as
the Pause length in the Scanning Criteria
window

e Tachycardia
e Bradycardia
e Irregular RR

e Minimum HR - the minimum heart rate
calculated using the heart rate algorithm
described in Appendix A, generally a four-
beat running average

e Maximum HR - the maximum heart rate
calculated using the heart rate algorithm
described in Appendix A, generally a four-
beat running average

* Shortest RR - the shortest RR interval
measured during the Holter period, exclud-
ing those before or after artifact

* Longest RR - the longest RR interval mea-
sured during the Holter period, excluding
those before or after artifact
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£ How Often Strips Auto Save | |

Maximum number of arrhythmia strips

Maximum number of ST events documented

Maximum number of strips per interval

Maximum strips per interval of the same name

Maximum strips of the same name

Minimum time {minutes) between strips of the same name

Maximum number of alternative strips (4

e Maximum strips of the
same name: Limit the
number of arrhythmia
strips of the same label that
are saved during the entire
Holter recording.

E3

e Minimum time (min-
utes) between strips of
the same name: Distribute
the arrhythmia strips saved
by requiring more or less

HENNEEE

| oK

time between those with
the same label.

Cancel

low Often Strips Auto Save window in Settings menu

How Often Strips
Auto Save

These settings control the distribution of
strips that are saved for the report. They
have the following uses:

e Maximum number of arrhythmia
strips: Saved strips fall into two types -
arrhythmia and ST. Limit how many
arrhythmia strips are saved for the final
report by adjusting this field.

e Maximum number of ST events docu-
mented: Each ST event, regardless of
whether it is depression or elevation, can
have five strips saved to document it. To
reduce the number of events for which
strips are saved, enter a smaller number in
this field. To change how many strips are
saved per ST event, make the change in
the What Strips to Auto Save window.

e Maximum number of strips per inter-
val: Interval length within the Holter
period is defined in the Scanning Criteria
window, but here you can control the
upper limit of how many arrhythmia strips
are saved within each interval.

e Maximum strips per interval of the
same name: Limit the number of arrhyth-
mia strips of the same label that are saved
within an interval.

e Maximum number of
alternative strips: Control
how many alternatives are available for
the following: Minimum HR, Maximum
HR, Shortest RR, Longest RR, Longest
VTAC, Fastest VTAC, Longest SVT,
Fastest SVT, Longest AF and Fastest AF.

To make changes, select the current entry
and type over it. Click on OK to save
changes and exit.

NorthEast Monitoring, Inc.

NEMMO027-Rev-S

Page 28 of 99



HE/LX Analysis Operator’s Manual

Holter Analysis: ST segment analysis

ST segment analysis

ST segment analysis includes these steps
(which are each explained in depth in the
following pages):

1.Setting ST markers. This is done
automatically by the software, but you
can adjust the markers for any patient.

2. Measuring the ST segment on all
three channels of every normal beat.
This is done automatically. If you rela-
bel normal beats to some other label,
the ST segment analysis will be re-
done automatically.

3. Plotting ST data in 30-second incre-
ments. All normal beats within each
30-second time period are averaged.

4. Establishing ST baseline for the
patient throughout the Holter period.
The software does this automatically
and plots it in blue on the ST trends in
the Trends window.

5. Comparing the 30-second ST seg-
ment data measured with the baseline
at the same time. A difference of at
least 1 millimeter in any channel is
considered to be an event. Again, the
software does this automatically.

6. Identifying ST events. ST events are
listed in the ST event table in the
Tables window. This is automatically
compiled for you, but you can edit any
of the fields within the table.

7. Documenting ST events. You deter-
mine which strips are saved to docu-
ment each event, based on the settings
in the What Strips to Auto Save win-
dow. How many ST events are docu-
mented is determined in the How
Often to Auto Save window.

Note: The procedure does not include
calibrating the signal because the data is
recorded at 1 centimeter per millivolt, the
standard for ST segment analysis.

Setting ST markers

To review the locations of the ST markers
used during analysis:

1. Select Review > Calibration. The Cal-
ibration window opens displaying the
calibration pulse, a series of eight 1-
millivolt square waves.

2. Click the but-
ton to the left of
“ST Marker” to
change the dis-
play to ECG
and three col-
ored, vertical
markers, which
include:

e the left-hand
marker (cobalt blue) indicates where
iso-electric is in the baseline preceding
the QRS complex;

ethe middle marker (yellow) is located
at or just following the j-point (where
the QRS ends and the ST segment
begins); and

ethe right-hand marker (light blue) is
located during the ST segment.

3 ST Markers

Note: Ifthe ECG displayed is not clean
and representative of the patient’s
normal, click the down arrow of the scroll
bar to jump forward to different ECG

3. If the markers are not located where
you want them, drag them to move
them to the appropriate locations. The
ST segment measurement can be made
at the location of either the j-point or
the ST segment marker, while the
other of the two is used to indicate the
slope of the ST segment. The time
between those two markers is listed in
the field labeled “ST Segment (ms).”
Be sure to locate each marker based on
your facility’s protocol.

NorthEast Monitoring, Inc.

NEMMO027-Rev-S

Page 29 of 99



HE/LX Analysis Operator’s Manual

Holter Analysis: ST segment analysis

Note: Each marker for each channel
moves independently so that you can
precisely position the markers based on
each channel’s morphology.

4. Once each marker is in the appropri-
ate location, click the button next to
Done. If you have made changes to
either the Gain or the ST Marker win-
dow, a window opens to ask whether
it’s okay to continue. Click on Yes to
make the change and continue. Click
No to cancel your changes and retain
the previous information

5. To exit from the ST Marker window
without saving your changes, click the
button next to Cancel.

Measuring the ST segment

This is performed automatically for all
three channels of ECG. Whether the ST
segment measurement is done at the posi-
tion of the j-point or the ST segment
marker is determined by the setting “ST
measurement” in the Preferences window.
See Chapter 8 for details of the Preferences
settings and their use.

The ST segment measurement is averaged
in 30-second increments throughout the
Holter period. Only normals not contami-
nated by artifact are included in each aver-
age. At least eight valid measurements
must be made within a 30-second period
for it to be included; if there are fewer than
eight clean normal beats, the 30-second
increment is considered artifact.

For any
particu- ST 1/0.75 |2/0.62 |3|1.12
lar beat
> ST 1, 2 and 3 fields
you can
mea-

sure the ST segment manually by going to
the Page display and selecting the beat as

the current beat. In the Expanded display,
drag the left marker to define iso-electric
and the right marker to the appropriate
location of the ST segment. The vertical
difference between where the two markers
intersect each channel of ECG is listed in
the ST 1, 2 and 3 fields in the Expanded
toolbar.

Plotting ST segment data

The data for all three channels is plotted in
the ST level display of the Trends window.
To display it, select Trends from the
Review toolbar and then select ST level in
the Type field.

The top trend is minute-by-minute heart
rate. Immediately below that is the ST
trend for channel 1, then channel 2, with
channel 3 on the bottom. Each trend shows
the patient’s calculated baseline as a cobalt
blue trend, with the patient’s ST measure-
ment plotted in green and the slope of the
ST segment indicated by a red vertical
line.

The software calculates the patient’s ST
baseline from the patient’s normal ST seg-
ment measurements as the Holtered period
progresses. ST segment changes that are
caused by positional changes result in
changes in the patient’s baseline, and are
not usually considered ST events them-
selves. The patient’s baseline during what
ends up being an ST event is interpolated
from the baseline before and after the
event.

The significance of establishing a patient’s
baseline is that it means that normal is not
always defined as iso-electric (that is, with
no voltage) and that significant changes
are relative to the patient’s baseline, not to
iso-electric.
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Identifying ST events

The ST analysis software looks through
the ST level trends, comparing the ST
trends to the patient’s baseline trends, to
find episodes of significant ST segment
changes.

For an incident to be called an ST event, at
least one 30-second ST segment data point
must be at least 1 millimeter different than
the patient’s baseline for that channel at
that time-of-day. A depression is a change
of at least 1 millimeter in the negative
direction, while an elevation is a change of
at least 1 millimeter in the positive direc-
tion.

In the ST level trends, incidents that are
flagged as ST segment events are indicated
by a light blue horizontal line above the
appropriate channel and lasting as long as
the event.

The events are listed in the ST event table
in the Tables window. To display it, click
Tables in the Review toolbar, then click on
ST event in the Tables list at the right of
the Tables window. In that table, the
description for each event includes:

¢ Channel - the channel in which the
event was detected

¢ Onset - the time-of-day at the start of
the event (defined as when the change in
ST segment passes through the point
0.5-millimeter different from the
patient’s baseline)

¢ End - the time-of-day at the end of the
event (defined as when the change in ST
segment returns to within 0.5-millime-
ters different from the patient’s baseline)

e Duration - the difference between the
end and the onset times

e Max HR - the maximum heart rate cal-
culated during the duration of the event

¢ Max ST deviation Time - the time-of-

day at the event’s maximum deviation
from the patient’s baseline

e Max ST deviation HR - the heart rate

during the event’s maximum deviation
from the patient’s baseline

e Max ST deviation Baseline - the ST

segment measurement’s deviation from
the patient’s baseline at the point of
maximum deviation

Max ST deviation Iso-electric - the ST
segment measurement’s deviation from
iso-electric at the point of maximum
deviation

& ST event edit gl
Channel [1] |

onset |10:45-1

End 111131

Duration |gp:28

Max HR. |22

Max ST dew.
Time (10:47-1

HR |75
Baseline [1.00
Iso-electric |1 52

Slope

[+ |
Integral (552

| OK | Cancel |

ST Event Edit window

e Max ST deviation Slope - the slope of

the ST segment event at the point of
maximum deviation (+ indicates upslop-
ing; - indicates downsloping; 0 indicates
horizontal)

Integral - the calculation that reflects
the area under the slope between the ST
trend and the patient’s baseline during
the event
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Note: If an event includes both a positive
component and a negative one, the integral
is actually less than the true area.
Although we report the absolute value, the
integral calculation can result in a
“negative” area, which when added to a
positive area can cancel some or all of it.

All of the information listed in the ST event
table can be edited by clicking the Edit but-
ton to open the ST Event Edit window and
making the changes you desire. To edit an
entry, drag across the existing entry and type
the information to replace it. When finished,
click OK to save your changes and exit.

To add an ST event, click the Add button.
The ST Event Edit window opens with
blank fields. Type the appropriate informa-
tion in each of the fields. Click OK to save
the event.

To delete an ST event from the table, click
on the event to be deleted, then click the
Delete button. The event disappears.

Documenting ST events

You control what strips are saved to docu-
ment ST segment events using a combina-
tion of settings in the What Strips to Auto
Save and How Often Strips Auto Save win-
dows.
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Pacemaker analysis

Pacemaker activity is recorded on North-
East Monitoring Holter Recorders without
distorting the patient’s ECG, by removing
the effects of the pacemaker spike and
replacing it with a pacemaker marker. That
marker, when re-introduced to the ECG
when the flashcard is read by the analysis
software, appears as a vertical spike in the
precise location of the original pacemaker
spike.

For the software to do a proper analysis of
the pacemaker activity during the Holter
period, the pacemaker settings in the Scan-
ning Criteria window must be set properly.
They include:

¢ Pacemaker type, which contains four
settings that allow the software to expect
certain behavior:

1.Not paced means that the software
will not identify any pacemaker
spikes, beats or failures.

2. VVI means that each paced beat will
be preceded by a single spike. All
paced beats are counted as ventricular
paced.

3. AV sequential means that paced beats
should be preceded by two pacemaker
spikes, one atrial and one ventricular.

4. DDD means that paced beats can be
preceded by either a one or two pace-
maker spikes. Depending on the
spike’s location relative to the follow-
ing R-wave, a beat preceded by a sin-
gle spike will be called either atrial
paced or ventricular paced, while a
beat preceded by two spikes will be
counted as AV paced.

e Minimum heart rate refers to the mini-
mum rate allowed by the pacemaker. If
the pacemaker does not fire appropri-
ately and there is a RR interval longer
than the patient should experience, the
Inhibition label appears.

¢ Maximum heart rate refers to the max-
imum rate initiated by the pacemaker. If
the pacemaker fires early, typically
because it did not sense the previous
beat, it would result in a faster rate, the
Sense failure label appears.

e Maximum vent. spike to R interval
sets the maximum time between the fir-
ing of the second pacemaker spike and
the following R-wave. If the second
spike appears and is not followed by an
R-wave in this amount of time, the Cap-
ture failure label appears.

¢ Maximum atrial spike to R interval
sets the limit for how long is allowed
between a single spike and the subse-
quent R-wave. If a single spike occurs
and the following R-wave is not within
this amount of time, the Capture failure
label appears.

¢ Paced beat and the beat after can be
called a SVPB is a setting that allows
you to identify early beats following a
paced beat as SVPBs because they were
premature, even if they themselves are
paced beats. Click on the check box to
turn it off and on.

Pacemaker labels

Beats can be identified and counted with
the following labels (refer to the diagram
on the previous page):

¢ A paced for a beat that is paced just in
the atrium. The atrial spike is deter-
mined to be the one that occurs well
before the QRS, falling before the
“Maximum ventricular spike to R inter-
val,” but within the “Maximum atrial
spike to R interval.”

¢ V paced for a beat that is paced just in
the ventricle. With pacemaker type set
to DDD or AV Sequential, the ventricu-
lar spike is determined to be the one that
occurs during the “Maximum ventricu-
lar spike to R interval.” This label also
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includes all paced beats with the pace-
maker type set to VVI and all beats
without pacemaker spikes that are man-
ually labeled “Paced.”

AV paced for a beat that is paced in both
the atrium and the ventricle, with the
atrial and ventricular spikes identified in
the same way as described above.

Sense failure means that the pacemaker

(1) did not sense a QRS that occurred

and (2) fired, resulting in a shorter-than-

programmed R-to-spike interval. The

label can happen under three scenarios:

1.Pacemaker type is set to DDD and
two pacemaker spikes occur, with less
than the “Maximum atrial spike to R
interval” between them, and with the
second spike more than 20 millisec-
onds after the QRS.

2. A single spike is more than 20 milli-
seconds after the QRS.

3. The time between the preceding QRS
and the next pacemaker spike is less
than 60 divided by the “Maximum
heart rate;” that is, the pacemaker fired
early.

Inhibition refers to inappropriate inhi-
bition of the pacemaker, resulting in a
longer-than-programmed RR interval.
This label appears if the time between

the preceding QRS and the next pace-
maker spike is greater than 60 divided
by the “Minimum heart rate” setting;
that is, the pacemaker fired late.

Capture failure means that the pace-
maker has fired, but there is no subse-
quent QRS within the allotted interval.
The label, which falls on the detected
QRS after the missing QRS, appears in
four scenarios:

1.The pacemaker type is DDD or AV
Sequential and there are two pace-
maker spikes, with the time between
them less than “Maximum atrial spike
to R interval” and the time between the
second spike to the QRS greater than
the “Maximum ventricular spike to R
interval” setting.

2. The pacemaker type is DDD or AV
Sequential and there is only one pace-
maker spike, with the time between the
spike and the following QRS greater
than the “Maximum atrial spike to R
interval” setting.

3. The pacemaker type is VVI and the
time between the pacemaker spike and
the following QRS is greater than the
“Maximum ventricular spike to R
interval” setting.

4. There are two pacemaker spikes that
are more than the “Maximum atrial

"'—j Maximum atrial spike to R interwval

Maximum wvent. spike to R interwval

— a0/Minimum HE & el

b Inhibition
— 50/ Maximum HE
SFenae failure

Diagram of pacemaker interval settings
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spike to R interval” apart and the time
from the first pacemaker spike to the
following QRS is greater than the
“Maximum ventricular spike to R
interval” setting.

Pacemaker table

Pacemaker counts are itemized in the
Paced table in the Tables window. To dis-
play it, click Tables in the Review toolbar,
then click on Paced in the Tables list at the
right of the Tables window. The Paced
table is an interval table and the reported
data includes:

e Time-of-day - the time-of-day at the
start of the interval;

¢ Total Beats - the total number of beats
identified and counted within the inter-
val, not including artifact;

e Time Analyzed - the total amount of
time analyzed during the interval; this
does not including periods that are con-
sidered to be artifact;

¢ Total Paced - total of the following 3
fields;

e Atrial Only - paced beats that were
determined to be paced only in the
atrium, not the ventricle;

e Vent(ricular) Only - paced beats that
were determined to be paced only in the
ventricle, not the atrium;

e AV - paced beats that were determined
to be paced in both atrial and ventricular
chambers;

* Sense Failure - the number of times
sense failures occurred (these are
defined in the previous section);

e Capture Failure - the number of times
capture failures occurred (these are
defined in the previous section);

e Inhibit(ion) - the number of times the
pacemaker was inappropriately inhib-

ited from firing (this is defined in the
previous section).

¢ Paced% - the percentage of paced beats
out of all beats in that interval.

The fields in this table can be edited as
described in the “Editing table entries”
section of the following chapter.

NorthEast Monitoring, Inc.

NEMMO027-Rev-S Page 35 0f 99



4. REVIEW METHODS

The Holter signal can be reviewed within HE/LX Analysis software in several ways: (1) Templates estab-
lished during analysis, (2) Critical Events where beats are placed in categories based on the most signifi-
cant events, (3) Saved strips which will appear on final report, (4) the Page screen which has on-screen full
disclosure of all the ECG recording, (5) the Trend graph that charts the heart rate and RR (6) Tables which
also can be included on the report, and (7) Superimposition and Calibration.

1. Bins/Templates

During analysis, the HE/LX software first determines what the patient’s normal QRS complex
looks like and establishes a template called “normal.” Each beat after that is compared to the
normal template; matches to that template are also called normal, while a similar but slightly dif-
ferent morphology will establish a new template, also called normal. A QRS complex that dif-
fers more significantly from the normal template will establish a template called “ventricular.” A
new template is established for each different morphology identified by the software. Subse-
quent matches to a template get labeled based on the template label, the timing of the beat, and
other criteria.

After analysis, the templates that generally look alike are grouped together in “bins.” You can
review these bins by morphology, that is, all normal bins or all ventricular bins. Within the Bin
window, you can also review by template, displaying all the templates within each bin, one bin

Bin Critical Events Sawved Strips  Page Trends Tables Reports
Morph (Ventricular 174/ 546 |w | Bin# 1 Matches 459

Bin All | % 1 -Bins 2 - Templates 3 - Beats 4 - Strips

y

L A o e obpb L L 1. "I

.\l ! Iy

L,\,r-h:jJ APl f - ‘
l"“’l Hﬁ_wll'\uﬂw_,.l., . 'ﬂ.\.||.r\'|ﬂ.,‘ ¥ n‘i

Ventricular bins in Bin window
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after the other. You can also review all
matches to each template, displaying them
one template after another.

Description of the Bin window

The Bin window opens with all templates
of a particular morphology (normal, ven-
tricular, paced, artifact or questionable)
displayed, up to a maximum of 16 bins.
The morphology drop-down lists how
many templates of that type were estab-
lished for this patient and how many total
beats were counted as this type. For exam-
ple, in the figure on the previous page,
there are 9 ventricular bins made up of 12
templates, and a total of 7,855 beats
matched the templates in those bins.

To change the morphology displayed,
click on the drop-down arrow to display
your choices, then click on the type you
want displayed.

In each bin display, the three channels of
the center beat are surrounded by an out-
lined box. That beat is the one that is in the
bin; the surrounding ECG is displayed to
show how the beat occurred, but is not
included in the bin. The number in the left
corner of each bin indicates how many
total beats matched the templates within
that bin.

To select a particular bin, click on it. The
time-of-day becomes outlined and the Bin
# and Matches fields now display data for
that particular bin.

Relabeling a bin

To relabel a bin and all of its contents (all
templates and matches), click on the bin to
select it, then click on one of the label but-
tons under the Morphology field. The rela-
bel buttons are not active unless one or
more bins are selected.

The relabel buttons include:

e A for artifact
e V for ventricular
¢ N for normal

e P for paced. (appears only if Pacemaker
mode is on in Scanning Criteria)

¢ Q for questionable/unknown

Note: No S label buttons appears here
because an SVPB matches a normal
template, but is early.

To relabel multiple bins, click on each of
the bins you want to relabel and then click
on the appropriate relabel button. To rela-
bel all of the displayed bins, click the All
button to select all the displayed bins and
then click the appropriate relabel button.

Undo

Before leaving one of the Bin views, you
can undo one or more relabels by clicking
Undo. Undo will restore all of the beats to
their state before the last relabel.

Single mode

Single mode button appears for Artifact
and any other morphology that has a beat
that has been relabeled. This is because
these beats are not assigned to a template.
Click the Single mode button to go to the
Beats screen where you can view and rela-
bel single beats.

Changing levels in Bin window

To display the templates within a particu-
lar bin, click on the bin and then click on
the Templates button.

Moving from one level of the Bin window
to the next can also be done by double-
clicking on the ECG in the bin, template,
or beats display. Each double-click
changes the button position one button to
the right.
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When a scroll bar appears to the right of a
field or window, you have the option of
using it or using the scroll button on your
mouse, if you have one.

Template display

The individual templates are presented
with two additional pieces of information
just underneath each template - the number
of matches to the template and the time-of-
day the template was established, that is,
the first occurrence of that template.

When you click to highlight a particular
template, the Strip # and Matches fields
update to reflect information about the cur-
rent template.

The template display contains up to 12
templates that matched the current bin. If
more than 12 templates fell into that bin,
you can access additional pages of tem-
plates by using the PageDown key, the
scroll bar or the Scan button. If you use the
PageDown key, once you reach the last
page of templates in the current bin, Page-
Down will display the templates that
matched the next sequential bin of the
same morphology type.

To display the templates in a different bin,
click the up and down arrows of the Bin #
field.

Relabeling a template

To relabel a template and all matches to it,
click on the template to select it (the time-
of-day of a selected template is surrounded
by a yellow box), then click on a label but-
ton under the Morphology field.

To relabel multiple templates, click on
each of the templates you want to relabel
and then click on the appropriate relabel
button. To relabel all of the displayed tem-
plates, click the All button to select all the

displayed templates and then click the
appropriate relabel button.

Note: If there are multiple pages of
templates within a bin and you relabel
one or more of them, blank spaces are
temporarily left where the template(s)
originally appeared. After paging up or
down and returning, the blank spaces are
gone.

Beats display

Clicking the Beats button displays up to 24
of the beats that matched the current tem-
plate. Use the PageDown, the Scan button,
or the scroll bar to display additional
matches to the template. The display
includes the time-of-day each beat
occurred, the template number the beats
matched (in the Template field), and the
total matches to the template (Strip #).

For the current beat, two blue vertical
markers appear. The markers can be used
to make measurements, which appear in
the data fields below the large time-of-day
field.

Drag the blue markers to appropriate loca-
tions to have the data fields display:

¢ HR (2RR) field shows the heart rate
calculation based on the blue markers
being two RR intervals apart.

¢ Time field indicates the time (in sec-
onds) between the blue markers.

e ST 1 field displays the vertical differ-
ence between where the markers inter-
sect channel 1. The left marker should
define iso-electric and the right marker
should be located where you want the
ST measurement made.

e ST 2 field displays the vertical differ-
ence between where the markers inter-
sect channel 2. They should be
positioned as indicated for channel 1.
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e ST 3 field displays the vertical differ-
ence between where the markers inter-
sect channel 3. They should be
positioned as indicated for channel 1.

Click the Both check box to drag the mark-
ers keeping them the same distance apart.
Click the Both box again to move the
markers separately.

To keep the calipers in the same locations
as you move through different screens of
ECG, click the check box next to Lock; the
calipers will stay in the indicated locations
unless you move them again. Click again
to turn off.

Relabeling a beat

The Beats window in Bin allows only sin-
gle-beat editing, which removes a beat
from its template and relabels just that
beat. To relabel a beat this way, click on
the beat to select it, then click on one of the
relabel buttons under the Morphology
field.

mla v NS BQT

Relabel buttons for beats and strips

In addition to the relabel buttons defined in
the “Relabeling a bin” section earlier in
this chapter, the relabel buttons for beats
and strips include:

¢ S for supraventricular
e T for T-wave

To relabel multiple beats, click on each of
them and then click on the correct relabel
button.

Saving sample strips for report

As you review the ECG, you can choose to
manually save sample strips for the report.
The 7.5-second sample strips are printed as
full-sized, 25-mm/second ECG on a back-
ground grid. To save a strip containing one

of the displayed beats, click on the beat
you want at the center of the strip to make
it the current beat, and then click Keep; the
Keep window opens. To label the strip,
either type the label in the Description
field or select a label from the scrolling
list; then click OK to save the strip.

For more information about the Keep win-
dow, see “Saving sample strips for the
report” in the Page window section of this
chapter.

StrIpS. dlsplay 7.5 5eCS

The Strlps display 15 seCs

g.rovlldes ? f}lill-screen 30 secs
isplay of the cur-

rent beat. All buttons, AISIES

fields, and markers el SO

work as described in  Display field choices
the previous section,

“Beats display,” with one addition - the
Display field. This controls the amount of
time that appears in the full-screen display.
Click on the arrow in the field to show
your choices, and click on your choice to
change the amount of time.

Move between Review Windows

All Review windows are linked by time-
of-day. In addition, the Page window is
linked to all other Review windows
through the right-hand button on the
mouse. From any other Review window, a
right-click will jump to the Page display,
retaining the current beat. After that, a
right-click in Page will then take you back
to where you originally were, regardless of
whether you change the current beat in the
Page window.
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2. Critical Events.

Every beat appears in a category in Critical
Events. For more information and an
explanation of how beats are labeled and
hierarchy, refer to the section entitled
“Beat Labeling” in Chapter 3.

Categories and Counts

The Critical Event categories and the count
in each is listed on the left-side of the
screen. If required, use the scroll bar to
view the complete list, and then select a
Critical Event category to display by click-
ing on it.

Note: Because of the way beats are
assigned into Critical Event categories,
the number of beats on this list will not
necessarily match totals on the Tables or
reports. As a beat that appears in one
category of Critical Events does not
appear in all other applicable categories.
For example, if a VPB appears in

Bigeminy, it does not appear in VPB; if a
paced beat appears in Sense Failure, it
does not appear in any other category.
Therefore, do not rely on the counts in
Critical Events to provide comprehensive
totals like the tables do.

To move through the displayed episodes,
use the Page Up (PgUp) and Page Down
(PgDn) keys, the scroll bar, the scroll but-
ton on your mouse, or click Scan to auto-
matically move from one display to the
next. Click the Scan button again to stop
the display.

Single/Multiple views

When a single episode is displayed, click
the Multiple button to display 12 at a time.
When multiple episodes are displayed, the
button label changes to “Single;” click that
to display just one episode. You can also
double-click on a strip to toggle back and
forth between the single and multiple dis-

HE/LX Analysis: Pat 1, 6.1 (C\nm61\pat\1)
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07:58:09.2am-02 Scan

!E:ZSJSTE

m

Reports

single| | Keep | Sort |RRiinterv:

02 406 ms

RR Interval (ms)

Critical Events window - multiple display

NorthEast Monitoring, Inc.

NEMMO027-Rev-S

Page 40 of 99




HE/LX Analysis Operator’s Manual

Review Methods: 2. Critical Events.

plays. Each event is labeled with time-of-
day and RR interval. In addition, if the
ECG appears in a strip saved for the
printed report, the word “saved” appears to
the right of the RR interval.

L_,.JJL,,MLAL
A
WERTUNE

_L.«l_‘»h\,u-—--L|L,-J_
b

S NTNEAN

09:59:21am-01 1050 ms

Current episode denoted by blue box

ST events

ST events are in the Critical Events list. If
you click ST Events, the strips showing the
maximum ST deviation during each event
are displayed. In addition, an ST event
table button is available to view tables
directly from this screen.

HR strips

Critical Events includes this display of all
the ECG recorded during the Holter
period, in 7.5-second strips. While some
beats may appear more than once in other
categories (because they are adjacent to the
current beat being displayed), this category
displays each beat in one strip only. The
heart rate listed is based on all beats pres-
ent in the displayed strip.

Saved strips

Saved strips are in the Critical Events list
so that you can review the strips saved for
the final report without leaving the Critical
Events window.

Sorting episodes within a
category

The Sort field lets you change the order of
the episodes within each type. You can
choose “RR interval” to put them in order
based on the RR interval, from shortest to
longest, starting with the current beat.
Unlike RR interval labeling elsewhere in
the software, which labels the interval
length from the current beat to the follow-
ing beat, sorting by RR interval in Critical
Events sorts based on the RR interval pre-
ceding the current beat; in that way, you
can review the most premature beats of a
type or the latest beats of a type.

The “Time” setting orders the episodes
based on the time-of-day of the event,
from earliest to latest.

The “24 hours” setting also orders them by
time-of-day, but the histogram at the top of
the window is divided into hourly inter-
vals. See the “Histograms” section below
for details.

Histograms

The top portion of the Critical Events win-
dow presents a histogram showing the dis-
tribution of the events within the type
displayed - either an RR histogram or a 24-
hour histogram.

The RR histogram plots the length of the
RR interval preceding each episode of the
displayed type. The number of events is on
the vertical axis (with a log scale) and RR
interval (in milliseconds) is on the horizon-
tal axis. The blue marker is located at the
position of the current event. To display
the event associated with an alternate RR
interval, click on the RR interval in the his-
togram; the appropriate event will appear
as the active event in the bottom portion of
the window.
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The 24-hour histogram shows how many
episodes of the displayed type occurred
during each 10-minute interval of the
recording. The blue arrow is located at the
position of the current event. To display
the events associated with a different time-
of-day, click on the histogram at that time;
the appropriate event will appear as the
active event in the bottom portion of the
window.

Count

o

o000 04 02 03
Cay 1

03:58
Cray 1

Time of day

24-hour histogram

Which histogram displays is based on the
setting in the Sort field. The settings “RR
interval” and “Time” display the RR histo-
gram; the setting “24 hours” displays the
time-of-day histogram shown above.

Data fields

In multiple view, the active episode is

denoted by a blue box. In single or multi-
ple view, the current episode has two blue
vertical markers (calipers) appear and can

‘HR{2RR:I 83

Time 143 ST 1062 |2]1.25 3037 [_Both

Data fields in Beats and Strips displays

be used to measure the beats. Drag the blue
markers to appropriate locations to have
the data fields display:

¢ HR (2RR) field shows the heart rate
calculation based on the blue markers
being two RR intervals apart.

e The Time field indicates the time (in
seconds) between the blue markers.

e The ST 1 field displays the vertical dif-
ference between where the markers
intersect channel 1. The left marker
should define iso-electric and the right
marker should be located where you
want the ST measurement made.

e The ST 2 field displays the vertical dif-
ference between where the markers
intersect channel 2. They should be
positioned as indicated for channel 1.

¢ The ST 3 field displays the vertical dif-
ference between where the markers
intersect channel 3. They should be
positioned as indicated for channel 1.

Click the Both check box to drag the mark-
ers keeping them the same distance apart.
Click the Both box again to move the
markers separately.

To keep the calipers in the same locations
as you move through different screens of
ECG, click the check box next to Lock; the
calipers will stay in the indicated locations
unless you move them again. Click to turn
off.

Relabeling in Critical Events

anvisibie| & [EllIT s BT

Relabel button options

To relabel a beat within the Critical Events
window, click on the event to select it.
When selected, the beat label will have a
yellow box around it. Once selected,
choose the beat label that you want to
change it to. Such as:

¢ A for artifact

¢ V for ventricular

¢ N for normal

e S for supraventricular

e P for paced (appears only if Pacemaker
mode is on in Scanning Criteria)
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* Q for questionable/unknown

e T for T-wave

To relabel multiple beats, click on several,
then click the relabel button.

To relabel all beats displayed on the cur-
rent page, click the All visible button, then
the relabel button.

The Histogram can also be used to select
beats to relabel. Click and drag to select a
range of beats using Histogram.

Multiple Page Relabeling

When a Critical Event category appears on
more than one screen (there are 12 per
screen), you can use the Invert Selection,
Clear All Selected and Select All in Cate-
gory buttons to pick and choose all of the
events prior to relabeling. As beats are
selected, the yellow box around the beat
will denote that it is included. Addition-
ally, the box will show how many beats
have been selected before doing the rela-
bel.

If need be, the Undo button can be used to
undo the relabeling over multiple pages.

VPB and SVPB relabeling

In addition, these relabel buttons appear
whenever the type displayed is an ectopic
event of either ventricular or supraventric-
ular origin:

¢ 1 Single - This will change all beat
labels to normal except for the current
beat, which will be called a single
SVPB or VPB, depending on its present
label. If the present type is SVT, this
button will remove the run that was
counted and replace it with an SVPB. If
the present type is VPB Pair, this button

will subtract the pair and replace it with
a VPB.

¢ 2 Pair - This will change beat labels so
that two sequential beats are called a
pair, either an SVPB Pair or a VPB Pair,
depending on its present label. If the
present type is VPB, this button will
change the selected event to be labeled
and counted as a VPB Pair. If the pres-
ent type is SVT, the selected run will be
relabeled and counted as an SVPB Pair.

¢ 3 Run - This will change beat labels so
that three sequential beats are called a
run, either SVT or VTAC, depending
on its present label. If the present type
is SVPB, a three-beat run of SVT will
replace the SVPB. If the present type is
VPB Pair, a three-beat run of VTAC
will replace the pair.

Save Strips for report

To save a strip containing one of the dis-
played beats, click on the beat you want at
the center of the strip to make it the current
beat, and then click Keep; the Keep win-
dow opens. To keep it with the current
label, click OK. To relabel the strip, type
the label in the Description field or select a
label from the scrolling list; then click OK
to save the strip.

To save multiple strips all with the same
label, click on each one to be saved, then
click the Keep button and click on the but-
ton that indicates multiple strips - it will
read “x strips,” with x equal to the number
of strips you selected before clicking
Keep.
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3. Saved Strips

The report includes full-size, 7.5-second,
25-mm/sec strips on a background grid.
Some strips are automatically saved based
on the settings in the What Strips to Auto
Save window. You can also use the Keep
button to manually save strips while
reviewing the Holter recording.

To review the saved strips, click Saved
Strips in the Holter menu. The Saved
Strips window displays a miniature version
of the strips 12 at a time. Each is labeled
with its strip label and the time-of-day at
which it occurred. Page through them
using either the PageUp and PageDown
keys, clicking on the up and down arrows
of the scroll bar, or using the scroll button
on your mouse.

VPE 03:01:40pm-01
A Saved Strip

The strips are initially sorted by strip label.
To review them ordered by time-of-day,
select Time from the choices in the Sort
field.

Note: ST event labels include the
channel in which the ST segment change
occurred.

Changing the active strip

At any time, there is only one active strip,
the strip outlined in blue. Four fields above
the strips refer specifically to the active
strip. Those fields include time-of-day, a

strip number, HR (heart rate) and HR2 (the
second heart rate, that is, the heart rate of a
run of VTAC or SVT in the strip).

To change the active strip, click on the one
you want so that the outline surrounds it.
You can also change the active strip by
clicking the List button in the toolbar to
open the List window. The List window
lists each strip label and corresponding
heart rate in order of time-of-day. To dis-
play a particular strip from the list, click on
the appropriate entry on the list and click
OK, or double-click on the entry.

Editing a strip label

To change the label of the active strip,
click on Edit in the toolbar. The Edit win-
dow opens; it includes a field with the cur-
rent label of the strip and the heart rate of
the ECG in the strip, along with the second
heart rate, the rate of either SVT or VTAC
if it is present. (A second heart rate of 0
indicates that there is no run on the strip.)

Description [vpE| [=]
HR |76
HR2 |5
| OK | | Cancel ‘
Edit window

You can either type over the existing strip
label in the Description field or select an
alternate label by clicking on the arrow at
the right end of the Description field and
selecting a label from the displayed list.

If you type the entry, the auto-fill feature
appears - as you type, the characters are
matched to the preset list and will automat-
ically fill in; if the text that appears is not
what you want, continue typing the entry
until it displays appropriately. If the label
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you want is not already on the preset list,
you must type the entire entry. Once the
correct label appears, press Enter.

To change the heart rate on the strip, click
on the HR field and type over the existing
entry. When you have completed your
changes, click OK to save.

Deleting strips

If you decide to delete one or more of the
strips from the final report, you can do that
in the Saved Strips window. To delete one
strip in the Multiple strip display, click on
it to make that strip the active one, then
click Delete in the toolbar. To delete more
than one strip, click on the first strip to
make it the active strip; in addition to the
blue highlight around the strip, there is
also a yellow highlight around the time-of-
day, indicating that the strip is selected.
Click on any additional strips you want to
delete, then click Delete in the toolbar. All
of the selected strips (as indicated by the
yellow highlight) are now deleted.

When you delete a strip, its label becomes
red; strips with red labels are not included
in the printed report. To retrieve a deleted
strip, click on it and then click Delete in
the toolbar again; the label text changes
back to yellow.

To delete all of the strips displayed, click
the button labeled Del/Undel All. To
retrieve all of the strips displayed, click the
button again.

Deleting channels from a strip

To delete one or more channels of a strip,
but not the entire strip, click on a strip to
make it active. Then, click on one of the
check boxes labeled Channel 1, 2 and 3.
For a particular strip, if a check is present,
the channel will be included; if a box is not
checked, the channel will be deleted. To

delete a channel from all strips, delete the
channel from the active strip, then click on
All

When the Confirm window appears, click
Yes to delete the channel(s) from all strips.

Replacing strip with alternative

Some strips can be replaced by an alterna-
tive: maximum and minimum heart rates,
shortest and longest RR intervals, and fast-
est and longest runs of VTAC and SVT.
The software selects sample strips for
those types automatically. If you would
prefer to select a different one (perhaps
because the selected one contains artifact),
click on the strip to make it active; the
Alternatives button appears.

When you click Alternatives, the Alterna-
tives window opens, displaying other
choices for that label. All categories except
the longest runs are sorted by heart rate,
with the worst case first; the longest runs
of SVT and VTAC are sorted by length,
longest first. The current selection is the
first one, in the upper left corner.

To select a different strip, click on the strip
and then the Select new Alternative button.
The window closes and the new strip
appears in the Saved Strips window. To
exit from the Alternatives window without
changing the strip, click the Back to Saved
Strips button.

Measuring

The data fields in the center of the toolbar -
HR (2 RR), Time, and the ST indicators
for each channel - contain data calculated
based on the two blue calipers in the active
strip. As you drag the blue calipers, those
fields change, reflecting the new caliper
positions.
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To measure a two-beat heart rate, place the All other buttons and fields work in the

calipers two RR intervals apart; the mea- Expanded display just as they do in the
surement appears in the HR (2 RR) field. Multiple strip display. Use PageUp and
To measure ST in any of the channels, PageDown to display the other strips.To
position the left caliper in the isoelectric return to the Multiple strip display, click

area of the PR interval and the right caliper Multiple in the toolbar.
where you want to make the ST measure-

ment; the measurements for each channel

appear in the appropriate fields.

To move the calipers keeping them the
same distance apart, click the check box
next to Both and then drag the calipers.
Click again to remove the mark and move
them separately.

To keep the calipers in the same locations
as you move through different screens of
ECG, click the check box next to Lock; the
calipers will stay in the indicated locations
unless you move them again. Click again
to turn off.

& Confirm

OK to delete/retain channels in all strips as shown in the current strip?
Yes No

Confirm window for deleting channel in All strips

Expanding the active strip

To view a strip more closely, either click
Single in the toolbar or double-click on the
strip. It then fills the Saved Strips window.
Each beat is labeled with either the heart
rate (BPM) or the length (in milliseconds)
of the RR interval following the beat.

The blue measurement calipers and the
related data fields work in this window
exactly as those described in the previous
section, “Measuring.”
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4. Page screen

The Page window allows you to review all
of the ECG stored during the recording,
like an electronic full disclosure. To open
it, click on Page in the Review toolbar.

Full screen/Expand button

Using the Full screen/Expand button, you
can toggle the window format back and
forth between (1) only a single-channel
display and (2) a combination screen with
a single-channel display on the top half
and an expanded strip on the bottom.

The single-channel page display contains a
blue highlight box surrounding one of the
QRS complexes, the “current” beat. The
time-of-day at that beat is displayed in the
time field in the upper left corner of the
window. To move the highlight box to a

12:10:44 3pm-01

different beat, click on the beat you want to
view and the new beat will now have a
blue box around it.

Other Page buttons

Scan. In the single-channel display, you
can visually review pages of ECG by using
the PageUp and PageDown keys, by click-
ing on the down arrow of the scroll bar, by
using the scroll button on your mouse, or
by clicking the Scan button. Turn the Scan
button off by clicking it again. Control the
speed of the scan by pressing + to make it
faster and - to slow it down.

Keep. The Keep button allows you to save
one or more strips. Saving strips is covered
later in this chapter.

Center. To adjust the ECG so that the
highlighted beat appears in the center of
the page, click Center.

Lead. To change the channel displayed,
click on the Lead field and select a differ-
ent channel from the list.

Gain. To change the

amplitude of the dis- Gain |[10__~ |
played signal, click on 0.25
the Gain field and 0.50
select a different size 1.0
from the list. 2.0

1.0

Zoom. To change the
amount of time dis-
played on each page, click on the Zoom
field and select a different amount of time.

Gain choices

Display. To change the amount of time
that appears in the expanded mode, click in
the Display field in the toolbar at the center
of the window and select the amount of
time to be displayed.

Print. To obtain a single-page printout of
the ECG on the screen, click Print in the
toolbar at the top of the Page window.

Invert/Hide. To invert the signal in a
channel or to hide it from view (because
the signal in one channel interferes with
your visual review of another channel) go
to Review > Invert/Hide to open the Invert/
Hide window. Click on the check box for
each channel to be inverted; click on it
again to return the signal to normal. Click
on the check box for each channel to be
hidden; click again to return it to normal.
Click OK to save any changes.

£ [nvert/Hide

Channel 1

] [l
Channel 2 [l [l
Channel 3 [l [l

Invert/Hide window
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Relabeling

To relabel in the Page window, click on the
beat to be relabeled, select the appropriate
setting for the Mode field, and then click
the appropriate relabel button.

AEN s Ear

The relabel buttons include:

e A for artifact

e V for ventricular

e N for normal

¢ S for supraventricular

e P for paced (appears only when Paced
mode is on in Scanning Criteria win-
dow)

¢ Q for questionable or unknown

e T for T-wave

Single vs. All Matches

The type of relabeling performed is deter-
mined by the setting in the Mode field.
Choices are:

e All matches

relabels the Mode | Single beat  ~ |

template to All matches
whatever Single beat
label you Relabel Modes

choose. It is

removed from its present bin and estab-
lished as a template in its new morphol-
ogy; all matches to that template have
the new label.

» Single beat relabels just the current,
highlighted beat to whatever label you
choose, removing the beat from what-
ever template and bin it was in and
installing it in a new template in its new
morphology.

Note: Although the S and T labels are
available on Page, only a single beat at a
time can be relabeled to S or T. Even if
Mode is set to All matches, only a single-
beat edit will be performed.

Relabel Multiple Beats

To relabel multiple single beats to the
same label, click on the first beat, then
press the Shift key and click on each addi-
tional beat. A blue highlight box surrounds
each of the beats to be relabeled; click the
appropriate relabel button. This method
does single-beat relabeling only.

To relabel a string of beats to the same
label, click on the first beat and then drag
across to the last beat; the beats turn
magenta. Then click the appropriate rela-
bel button. This method does single-beat
relabeling only.

Note: Whenever you use a relabel
button, a message appears in the bottom
strip of the window indicating what label
was given to the beat and how many beats
were relabeled. In addition, error
messages appear there whenever you try
to relabel inappropriately.

To undo a relabel, click the Undo button.
The labeling reverts to just before the last
relabel.

Turning AF On/Off

If a patient is in intermittent atrial fibrilla-
tion or flutter and you want to create a sin-
gle AF event, click on the first beat and
then drag across to the last beat.The time
period turns magenta. Now click the AF
On button. No SVPBs will be counted dur-
ing that time period and will instead be
counted as AF.
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To change a period of AF to Normal,
repeat the process, but click the AF Off
button instead.

Afib | On | | Off

AF On/Off buttons

Inserting a beat

If while you are reviewing the ECG in the
Page window, you see that a particular beat
is included in the highlight box of the pre-
ceding beat, it means that the beat was
missed. This is usually because of very
low amplitude, but sometimes because of
low slope. To force the system to count the
beat, you can use the Insert button in the
Expanded Page toolbar.

Time  04:29:18 3pm-1

OK | | Cancel |

Insert window

To insert a beat, first click near the beat so
that it appears in the Expanded Page dis-
play, then drag or click the left-hand cali-
per to the location of the missed QRS
complex. Click the Insert button in the
toolbar in the middle of the window. The
Insert window opens, with the time-of-day
of the new beat listed in the first field and a
beat label in the Morphology field. Click
on the arrow in the Morphology field to
display the list of label choices and make
your selection. Then click OK to insert that
type of beat where the left-hand caliper is.

Saving strips for the report

As you review the ECG, you can choose to
manually save sample strips for the report.

The 7.5-second sample strips are printed as
full-sized, 25 mm/second ECG on a back-
ground grid.

To save a strip, click on the beat you want
at the center of the strip to move the high-
light box there, and then click the Keep
button; the Keep window opens. The
Description field contains the current beat
label; to keep that label, leave the field as
is. To relabel the strip, either type the label
in the Description field or select a label
from the scrolling list; then click OK to
save the strip.

Description [VPE PAIR =]

HR [0 |
HR2 [0 |

| OK | | Cancel |

Keep window with OK button

The Keep window also includes two heart
rate fields: HR, which equals the heart rate
of the background rhythm of the strip, and
HR 2, which is the rate of the run (VTAC
or SVT) on the strip, if there is one. HR 2
equal to 0 means that there is no run on the
strip. Both fields can be edited if you
choose to. Be sure to make any measure-
ments before you click Keep because the
calipers are not accessible when the Keep
window is open. Once the label and the
heart rate fields contain the information
you want, click OK.

To save strips of an event longer than 7.5
seconds, drag the cursor across the ECG to
be saved (the selected ECG turns magenta)
and then click Keep. In the Keep window,
you can enter the label of the first strip in
the series and then click the left button,
which indicates how long a time period to
be saved. Subsequent strips in the series
will be labeled “Continuous (x/n)” (mean-
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ing strip number X out of a total of n strips
in the series).

Description [BIGEMINY |~

HR2 [0 |

| 21 seconds || Cancel |

Keep window with time button

To save multiple strips, all with the same
label, click on a beat at the center of the
ECG to be saved, then hold the Shift key
down and click on another beat. Then click
Keep. In the Keep window, click the but-
ton labeled “n strips” to save all the
selected examples; click the button labeled
“1 strip” to save just the last beat selected.
All saved strips will have the label in the
Description field; change it when appropri-
ate. Because the strips are likely to have
different heart rates, no heart rate fields are
presented.

Description |vPg| [=]

| 3 strips | | 1 strip | | Cancel |

Keep window with multiple strip button

Measuring in Expanded Page

The two blue vertical calipers that appear
in the Expanded strip in Page can be used
to make a variety of measurements. To
measure, drag the calipers to specific loca-
tions on the ECG; or click on the ECG to
move the closer caliper to that location. To
move both calipers while keeping them the
same distance apart, click on the Both
check box in the center toolbar and then
drag or click them to a new position; click
the Both check box again to move each
caliper separately.

To measure the heart rate on the strip,
place the calipers two RR intervals apart;
the heart rate appears in the HR (2 RR)
field. To measure an RR or a PR interval,
place the left caliper at the start of the
interval and the right caliper at the end of
the interval; the time between them
appears in the Time field.

To keep the calipers in the same locations
as you move through different screens of
ECQG, click the check box next to Lock; the
calipers will stay in the indicated locations
unless you move them again. Click again
to turn off.

ST 10682 2037 3025 Slope 1 |0.50

ST segment and slope measurement data boxes
1

o make ST measurements, place the
left caliper in the isoelectric portion
of the PR interval, and place the
right caliper where you want the ST
segment measurement to be made;
the vertical distance between where
the left caliper intersects the ECG
and where the right caliper intersects
the ECG will appear in the ST field
for each channel (labeled ST 1, 2, 3).
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5. Trends window

Open the trends window by clicking on
Trends in the Review toolbar or by select-
ing Review > Trends in the primary Holter
toolbar.

General Trend

The General trend screen presents data in
one-minute increments throughout the
Holter period, including the RR trend
showing the range of RR interval measure-
ments; the heart rate trend showing the
average heart rate; total VPB and VTAC
trends; and total SVPB and SVT trends

HR 66 ||RR Min [0.68 |Max [1.13
O4:09pm-1  05-1 OG- o7-1 0z-1
2_|III|III|IIIIIIIII
e -
14
|:| -

RR trend with min and max indicated

On all of the trends, time-of-day appears
on the horizontal axis. RR intervals are
plotted so that the range within each min-
ute appears as a vertical line; the top end of
the line indicates the longest RR interval
within that minute, and the bottom of the
line indicates the shortest RR interval
within it.

ST Trend

The ST trend screen presents the ST seg-
ment analysis data in 30-second incre-
ments throughout the Holtered period for
all channels of ECG data. The placement
of the ST calipers is automatic unless you
re-set them in the Calibration window. See
the section “ST segment analysis” in the
previous chapter for more detailed infor-
mation about ST segment analysis.

The ST trends include three components
for each channel: (1) the patient’s baseline
ST measurement, that is, the patient’s nor-
mal ST; (2) the actual measurement made
for each 30-second increment; and (3) the
slope indicator for each 30-second indica-
tor. The baseline measurement is trended
as a blue line, the actual measurement is
green, and the slope indicator is a vertical
red line drawn from the actual measure-
ment to the measured value at the slope
caliper.

The blue marker

The blue vertical marker is located at the
time-of-day of a particular 30-second seg-
ment. Click on either trend to move the
marker to a different time-of-day. The
time-of-day that appears in the large data
box indicates the time-of-day at the
marker. The data boxes at the top of the
display indicate the data collected for the
minute where the marker is located,
including heart rate (HR), the shortest RR
interval (RR Min), the longest RR interval
(Max), the total number of VPBs and
SVPBs, and the total number of VPBs and
SVPBs that occurred during runs of VTAC
and SVT. In addition, the ST data boxes
include data collected for the 30-second
interval where the marker is located,
including the ST segment measurement for
each channel in ST 1, 2 and 3, and the ST
slope measurement for each channel in
Slope 1, 2 and 3.

Asterisks indicate that there is no data for
that time period, usually because of arti-
fact.

Relabeling to artifact

If entire periods are contaminated by arti-
fact or if the electrodes were removed
early (which generates lots of high fre-
quency noise without ECG at the end of
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the Holter data), you can relabel continu-
ous periods of data artifact.

In the Trends window, to relabel a continu-
ous period as artifact, click at the time-of-
day you want to start rejecting and then
drag until the end time. The time period
turns magenta. Now click the Artifact but-
ton. A message will appear asking whether
you mean to relabel the period as artifact.
Click Yes to do so. All of the data within
that time period is now called artifact, col-
ored light blue, and not included in any of
the totals.

Shorten analysis time

If the Holter period ends prematurely, you
can either throw out the information as
artifact, as described in the section above
or you can shorten the analysis time.

To shorten the analysis time, in the Trends
window, click to move the marker to the
time-of-day at which you would like to end
analysis, then select Review > Shorten
analysis time. When the window opens to
confirm the command, click Yes to re-ana-
lyze the data, stopping at the time indi-

cated. To close without re-analyzing, click
No.

Turning AF On/Off

If a patient is in intermittent atrial fibrilla-
tion or flutter and you want to create a sin-
gle AF event, click on the trend on the
begin time and then drag across to the end
of the AF time. The time period turns
magenta. Now click the AF On button. No
SVPBs will be counted during that time
period and will instead be counted as AF.

To change a period of AF to Normal,
repeat the process, but click the AF Off
button instead.

Afib |On | | Off

AF On/Off buttons

Amount of time displayed

You can expand the trends by decreasing
the amount of time displayed across a sin-
gle page. To change the amount of time
displayed, click on the arrow in the Hours

|HR(2RRJ 79 |Time 151 |sT1|050 2042 |3 062 | [(JBoth [ Lock Display [7.5secs w | [msert]
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Calipers placed two RR intervals apart to measure heart rate
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field and select the number of hours you
want displayed per page.

When Hours is set to less than 24 for a 24-
hour recording, there are multiple pages of
data. To move from one page of data to the
next, use either the PageUp and PageDown
keys on your keyboard, or the scroll bar.

6. Tables

Tables to be included in the final report
include interval tables of general, ventricu-
lar, supraventricular, ventricular runs,
supraventricular runs, pacemaker data,
bigeminy, and tachycardia and bradycardia
data, along with a table listing episodes of
significant ST segment change.

To review the tables compiled for a
patient, click Tables in the Review toolbar.
The listing of what tables are available
appears at the right of the screen. The dis-
played table is highlighted in blue. To dis-
play a different table instead, click on its
name in the list.

The tables and their fields include:

¢ General - This is an interval table that
lists the time-of-day at the start of the
interval; the low, mean and high heart
rate calculated during the interval (see
appendix A for details of heart rate cal-
culations); the total number of beats
identified and counted in the interval
(this excludes periods of artifact); the
amount of time analyzed (this also
excludes artifact); the total number of
SVPB beats; the total number of VPB
beats; the number of pauses; and a field
for manually-entered rhythm com-
ments.

¢ Supraventricular - This is an interval
table that lists the time-of-day at the
start of the interval; the total number of
beats identified and counted in the
interval (this excludes periods of arti-
fact); the amount of time analyzed (this
also excludes artifact); the total number
of SVPBs counted; the number of sin-
gle SVPBs; the number of SVPB pairs;
the number of runs of SVPB; and the
number of SVPBs that occurred in runs.

¢ Ventricular - An interval table that
lists the time-of-day at the start of the
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interval; the total number of beats iden- rences of inappropriate inhibition; and
tified and counted in the interval (this the percentage of paced beats.
excludes periods of artifact); the
amount of time analyzed (this also
excludes artifact); the total number of
VPBs counted; the number of single A
VPBs; the number of VPB pairs; the previous chapter.

number of runs of VTAC; and the num-  « Supraventricular runs - An interval

Note: Details of the pacemaker analysis
and labels are provided in the
“Pacemaker analysis” section of the

ber of VTAC beats that occurred in
runs.

¢ ST Event - This table lists the ST seg-
ment events that were detected during
the Holter test. Data in this table
includes the channel in which the event
was detected; the time-of-day at the
start of the event; the time-of-day at the
end of the event; the duration of the
event; the maximum heart rate calcu-
lated during the event; the time-of-day
at the event’s maximum deviation from
the patient’s baseline; the heart rate
during the event’s maximum deviation
from the patient’s baseline; the ST seg-
ment measurement’s deviation from the
patient’s baseline; the ST segment mea-
surement’s deviation from iso-electric;
the slope of the ST segment event at the
point of maximum deviation; and the
integral of the event.

Note: Details of ST segment analysis and
labels are provided in the “ST segment
analysis” section of the previous chapter.

e Paced - An interval table that lists the
time-of-day at the start of the interval;
the total number of beats identified and
counted in the interval (this excludes
periods of artifact); the amount of time
analyzed (this also excludes artifact);
the total number of beats counted as
paced; the number that were atrial-
paced only; the number that were ven-
tricular-paced only; the number that
were paced in both chambers; the num-
ber of sense failures; the number of
capture failures; the number of occur-

table that lists the time-of-day at the
start of the interval; then the number of
3-beat, 4-beat, 5-beat, 6-t0-9-beat, and
10+-beat SVT runs. It also includes
number of beats included in AF events,
the number of AF events, and total AF
time.

Ventricular runs - An interval table
that lists the time-of-day at the start of
the interval; then the number of 3-beat,
4-beat, 5-beat, 6-t0-9-beat, and 10+-
beat VPB runs that occurred at a rate
less than the VTAC heart rate setting in
Scanning Criteria; then the number of
3-beat, 4-beat, 5-beat, 6-to-9-beat, and
10+-beat VPB runs that occurred at a
rate equal to or more than the VTAC
heart rate setting in Scanning Criteria.

Bigeminy - An interval table that lists
the time-of-day at the start of the inter-
val; the total number of beats identified
and counted in the interval (this
excludes periods of artifact); the
amount of time analyzed (this also
excludes artifact); the total number of
VPBs that occurred in bigeminy; the
number of 3-VPB episodes of bigem-
iny; the number of episodes of bigem-
iny that included 4 through 9 VPBs; the
number of episodes of bigeminy that
included 10 through 24 VPBs; and the
number of episodes of bigeminy that
included 25 or more VPBs.

Tachy/Brady - An interval table that
lists the time-of-day at the start of the
interval; the total number of beats iden-
tified and counted in the interval (this
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the ST event) the Edit button opens the
Interval Table Edit window that allows
you to change information within the data
fields for a particular interval. To use the
Edit button, first click on a particular inter-
val in a table to highlight it, then click Edit.

ST1|0.62 |2|(0.37 [3|0.25 Slope 1 050 2012 |3 012

ST segment and slope measurement data boxes

excludes periods of artifact); the
amount of time analyzed (this also
excludes artifact); the number of beats

of bradycardia that occurred as defined
by the Bradycardia setting in Scanning
Criteria; the amount of time spent in
bradycardia; the number of beats of

Note: If you choose to edit tables, this
should be the last thing you do before
creating the report, as calculated values
are recalculated every time you do an

tachycardia that occurred as defined by
the Tachycardia setting in Scanning
Criteria; and the amount of time spent
in tachycardia.

Update or Reanalyze the data.

Note: If you have already created a front
page, you will need to do a View
Summary > Reset to ensure that table
changes are incorporated on the front

Printing tables
9 page of the report.

To print a displayed table, click Print to
open the Print window, then click OK to

print. Editable fields appear with data against a

white background. Fields that you cannot
edit have a blue background. For example,
total beat counts are not editable because
they are calculated from other field data
present in the table; as you make changes

Editing table entries

To edit information that appears in the
tables, you can either use the Edit or the
Zero button. In the interval tables (all but

[ Interval Table Edit =]
Time beginning 11-12am-01 Brady time (000000 | Total paced o Sense failure [0 |
Time analyzed 00:45:52 Brady beats [o | Atrialpaced [0 | Capture failure [0 |

Low HR M Tachy time ,m Ventricular paced D Inhibition failure D

Mean HR [gg | Tachy beats [1395 | Avpaced [p |

High HR ’E Pauses D Comment | |m
Total beats 4530 Bigeminy beats [570 | Comment thru

entricular Supraventricular
VPBtotal 1236 SVPBtotal o
VPE singles [1030 | SVPB singles [0 |
VPB pairs [103 | SVPB pairs [g |
RonT [0 | EarlyVPB [0 | Aberrant [0 |
VTAC beats o SVT beats o
VWTAC runs o SVT runs 0
VTAC HR < |20 | == AFEvents [p |
3o | o | AF Time [00:00:00 |
4o | o | SVT HR <75 | ==
5 ’n—| o | #beats = #beats>= 3 D D
69 o | o | o | fo ] 2o | o]
10+ |D | |D | |D | |D | 5 ’ﬁ o | #beats< #beats>=
69fo | o | o | [o_ |
0o | Jo | o | [0 |

Interval Table Edit window
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to the other fields, the total counts change
appropriately.

To completely eliminate all information
within an interval, use the Zero button,
which opens the Interval Table Zero win-
dow.Click on as many data fields as you
want zeroed out in the interval tables, then
click OK.

Select/deselect all buttons are available for
each section. Use them to turn on or off all
data fields within each specified section -
general information, ventricular, or supra-
ventricular.

6. Additional features

Superimposition

HE/LX Analysis
software allows you
to review the
patient’s ECG in
superimposition
mode. In superimpo-
sition, each beat is
quickly superim-
posed upon the pre-
ceding one in a
continuous stream,
which allows you to
easily identify
rhythm changes.
Normal beats, VPBs
and artifact are
superimposed in sep-
arate locations in the
Superimposition
window so that you
can also verify beat
identification.

-

To open the Super- Superimposition
imposition window,

select Superimposition from the drop-
down Review menu. Click on Scan to start

and stop the superimposition display.

In the display, channel 1 appears on top,
channel 2 in the middle, and channel 3 at
the bottom. Beats that match normal and
paced templates are superimposed at the
left side of the window, while beats that
match ventricular templates appear in the
center, and signal that is considered artifact
appears to the right of the window.

Control the speed of the scan by repeatedly
pressing + to make it faster and - to slow it
down.
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Calibration

Although the NorthEast Monitoring Holter
Recorders save the patient’s Holter signal
at standard calibration, you can display the
calibration signal at the start of the record-
ing and adjust the height.

B

Calibration signal with markers

To open the Calibration window, select
Calibration from the drop-down Review
menu. Three channels of calibration signal
are displayed. The two horizontal lines for
each channel should be lined up so that one
is level with the top of the square wave and
one is level with baseline. Drag the lines to
move them.

& Confirm

Re-calibration will cause all prior changes to be lost.
OK to continue?

Yes No

To close the Calibration window without
saving new marker locations, click Cancel.

In addition, you can use the Calibration
window to increase the size of a very low-
voltage ECG signal or decrease the size of
a very high-voltage signal, if the size
causes problems during analysis. To
increase the size of the signal for analysis,
set the horizontal gain markers close
together. To decrease the size of the signal
for analysis, set the horizontal gain mark-
ers far apart.

Note: If you use the gain markers in this
way, the signal is no longer calibrated
and no ST measurements are correct.

ST Markers

The Calibration window is also used to
access and adjust the ST markers used dur-
ing ST segment analysis.

Details of adjusting the markers and all
other aspects of ST segment analysis are
provided in the “ST segment analysis” sec-
tion of the previous chapter

Confirm window after changes in Calibration

When finished, click on Done to save the
new positions. A Confirm window will
appear, asking you whether you really
want to re-analyze using the new marker
positions. Click on Yes to continue, and
click on No to retain the previous marker
locations.

Note: Whenever you make changes in
the Calibration window, the signal must
be re-analyzed when you exit. If you
choose to not re-analyze, the changes are
not saved.
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Heart Rate Variability (HRV) software allows you to review information about a patient’s normal-to-nor-
mal RR interval data in a wide variety of ways, including Lorenz, 3-dimensional, circadian and time-
domain plots. In addition, HRV information is reported in tabular formats of both time and frequency
domain. Tables include calculations standard for HRV analysis, including SDNN, SDSD, RMSSD, NN50
count, pPNN50, and a variety of indices - HRV triangular, differential and logarithmic.

Reviewing HRV data

Review the HRV data by selecting one of the items from the HRV drop-down menu
in the main Holter menu bar.

Note: HRV Analysis can only be performed when the Analysis time is 24
hours or less. For this reason, the HRV menu option from the toolbar will
be disabled when the Analysis duration is greater than 28 hours.

Lorenz Plot

These are scatter dia-
grams comparing the
RR interval following 2500
the current beat to the
RR interval prior to the
current beat. You can
choose to display all RR
intervals, only normal-
to-normal RR intervals,
only RR intervals on
either side of a ventricu-
lar ectopic, or only RR
intervals on either side
of a supraventricular
ectopic. Make your

2000

1500

RR previous (ms)

1000

selection in the Morph o

field by clicking on the

arrow and then clicking RR current {ms)
. Lorenz Plot

on your choice.You can

change the range on the two axes by making a different selection in the Scale (ms)

field. Your choices are 1000, 2000, 3000, 4000, or 5000. Click on the arrow in the

field and then click on your choice to change the setting.

T T T T T T T
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o
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In addition, the number of beats plotted on than 50 milliseconds different from the

a particular Lorenz scatter diagram is indi- preceding RR interval;

cated in the Matches field. ¢ MeanRR - the average RR interval
within the specified time period; and

Time Domain Plots e ProcTime - the amount of time (in sec-

Access these by selecting HRV > Time onds) processed within the interval.

Domain Plots. If spectral analysis has not
yet been run for this patient, a query box
appears asking whether to run it. In order
to view the time domain plots, spectral
analysis must have been run for the
patient.

To read specific data from the trends, click
on the time-of-day of interest and a blue
marker appears. The data fields at the top
of the window indicate the specific reading
for each calculation at the time-of-day of
the blue marker.

To change the number of hours displayed,

OK to run spectral analysis? make your selection from the list of
choices in the Hours field. To display the
Yes | | Mo choices, click on the arrow to the right of

the field. Click on your choice to select it.

Confirmation query

Tables

Three different tables are available for
review. Please note that these are accessi-
ble using the HRV menu, not the Holter
Tables window.

Click Yes to run spectral analysis and then
display the requested data; click No to
close the window without running spectral
analysis or displaying the data.

The time domain plots contain separate

trends of these different measurements and
calculations over time for each interval: This tabulates this information for the

entire Holter period:

Summary of Time Domain

¢ SDNN - the standard deviation of the
normal-to-normal RR intervals; e SDNN - the standard deviation of the

e RMS - the root mean square of the dif- normal-to-normal RR intervals;

ferences between sequential RR inter- * SDANN -the standard deviation of the

vals; normal-to-normal RR intervals for each
e SDSD - the standard deviation of the S -minute period of the 24-hour record-

differences between sequential RR ng,

intervals; e RMSSD - the root mean square of the
e NN50 - the number of normal-to-nor- differences between sequential RR

mal RR intervals that were more than intervals;

50 milliseconds different from the pre- * SDNN index - the mean of the standard

ceding RR interval, deviation of all normal-to-normal RR

intervals for all 5-minute segments of a

e PNNS5O - the percentage of normal-to- ]
24-hour recording;

normal RR intervals that were more
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SDSD - the standard deviation of the
differences between sequential RR
intervals;

NN50 count - the number of normal-to-
normal RR intervals that were more
than 50 milliseconds different from the
preceding RR interval;

PNNS50 - the percentage of normal-to-
normal RR intervals that were more
than 50 milliseconds different from the
preceding RR interval;

HRY triangular index - an index cal-
culated by first determining the density
of beats vs. RR intervals (scaled to a
sampling rate of 128 per second), then
dividing the total number of beats by
the peak density.

TINN - a variation of the triangular
index described above.

Differential index - an index describ-
ing the differences between the widths
of the histogram of differences between
adjacent RR intervals measured at the
of 1,000 and 10,000 beats.

Logarithmic index - coefficient ¢ of

the negative exponential Ke™ that is
the best approximation of the histogram
of absolute differences between adja-
cent RR intervals.

Spectrum slope on log-log plot - slope
of the linear interpolation of the long-
term (24-hour) spectrum in a log-log
scale. This is the value B of the function
(log(f)-a)/p that gives the best estima-
tion of the function log(P(f)) where P(f)
is the power density of the spectrum.

Ranges values of entire 24 hours - the
values defining each frequency range
for this patient.

Interval length - the amount of time
(in seconds) included in each interval.
Number of intervals - the number of
intervals included in the 24-hour
recording;

Values per interval - the RR tacho-
gram is sampled every (interval length)/
(values per interval) seconds to calcu-
late the long-term (24-hour or proce-
dure length) spectrum.

¢ Frequency resolution of short-term
spectrums - this is the size of the step
in frequency used to make all calcula-
tions for each interval (100 or 300 sec-
onds).

¢ Frequency resolution of 24-hour
spectrum - this is the size of the step in
frequency used to make all calculations
for the long-term spectrum (24-hour or
procedure length).

Time Domain

This reports the time domain information
for the included data. The table includes:

e # - the data number;
¢ Time - the time-of-day of the data;

e SDNN - the standard deviation of the
normal-to-normal RR intervals;

¢ RMS - the root mean square of the dif-
ferences between sequential RR inter-
vals;

¢ SDSD - the standard deviation of the
differences between sequential RR
intervals;

e NNS5O0 - the number of normal-to-nor-
mal RR intervals that were more than
50 milliseconds different from the pre-
ceding RR interval;

e pNNSO - the percentage of normal-to-
normal RR intervals that were more
than 50 milliseconds different from the
preceding RR interval;

e Mean RR - the average RR interval;

¢ Proc. Time - the amount of time
included;

o # Beats - the total number of beats used
for the calculations.
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Frequency Domain

This reports the frequency domain infor-
mation for the included data. The table
includes:

e # - the data number;
¢ Time - the time-of-day of the data;

¢ Regular VLF (very low frequency),
LF (low frequency), HF (high fre-
quency) and Total - the actual calcula-
tions made for the data indicated;

e Normalized LF (low frequency) and
HF (high frequency) - the relative
amount of high versus low frequency
data expressed as a percentage of the
total.

Note: For a valid interval for the calcu-
lation of HRYV time domain variables, the
number of valid beats must be at least
greater than the “minimum percentage of
an interval which is valid” which defaults
to 90%. Invalid beats are paced, pauses,
AF, VPBs, SVPBs and artifact.
Additionally there must be at least one
100 second period in the interval free of
repeating arrhythmia such as bigeminy
and trigeminy, as well as multiple VPBs
or SVPBs in a row.

HRYV Analysis

To perform HRV analysis, the software
considers only normal-to-normal RR inter-
vals and performs the analysis based on the
settings available in Settings > Spectral
Analysis.

Spectral Analysis settings

The following settings are available in the
Spectral Analysis window:

¢ Run spectral analysis after analysis
completes. This setting determines
whether HRV analysis will be done

automatically at the end of Holter anal-
ysis. A check mark in the check box
indicates that the HRV program will run
automatically upon completion of
Holter analysis. No check mark indi-
cates that HRV analysis will not be per-
formed automatically. If the HRV
analysis has not been done and you ask
to review HRV data, the software will
ask whether you want to run it at that
time.

Window type. This field indicates what
type of sliding window is used for HRV
analysis and what type of window to
use. The choices are None (simple slid-
ing window), Hamming, Hann, and Tri-
angle. Click on the arrow in the field to
list the choices and click on your selec-
tion.

Size (secs.). This setting determines
whether the sliding window is 100 or
300 seconds long. Click on the arrow in
the field to list the choices and click on
your selection. A setting of 100 limits
the minimum frequency to 0.01 Hz.,
while 300 limits the minimum fre-
quency to 0.0033.

Take average of logs. As HRV analy-
sis is done, you can choose to have the
magnitude of spectral values first con-
verted to a log form before averaging.
A check mark in the check box indi-
cates that the data will be converted; no
check mark indicates that the average is
performed on the magnitude of the
spectral values directly and the log, if
any, is taken after the average.

Number of seconds over which the
spectral average is made. The average
of the spectrum is a two-dimensional
calculation made using a sliding win-
dow. The window is the “Size”
described above; it moves “Spacing
between averages” described below
between each spectrum calculation.
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| much artifact or
[] Run spectral analysis after analysis completes .eCtOPY Wlt.hll’l an
interval will pre-
Hindowtype [Hamming [~] vent it from being
Szedsecs) 300 L included. Click on
Take average of logs the field and type
Number of seconds over which the spectral average is made @ your entry to
Frequency range used for average IE change the set-
Spacing (secs.) between spectrums for average calculations til’lg.
Minimum percentage of an interval that is valid @ ° Lower/upper
Lowerfupper limits for differential index measurements l@ ,@ limits for differ-
Extrapolate |Restart [~ ential index mea-
TR e surements. The
‘ USR1  USR2  VIF LF HF  Total USR3 differential index
Beginning of frequency ranges [0.0001 |[0.003 |[0.01  |[[oo4 |Jo1s  |[o.01 |[o.0001 | measurement is
End of frequency ranges [0.003 |[0.04 [[o.04 [[o15 |jo40  [lo40  [foa0 | defined as the dif-
ference between
lonson {0 llncmenl | he widths of the

Spectral Analysis Settings window

This setting is the total number of sec-
onds the window must move to calcu-
late one point in the result. The range
allowed is from 0 to 3600. Click on the
field and type your entry to change the
setting.

Frequency range used for average.
The average is made over this range of
frequencies. Click on the field and type
your entry to change the setting.

Spacing (secs.) between spectrums
for average calculations. The number
of seconds the window is moved for
each spectrum calculation used to cal-
culate the average spectrum. When this
is set to the typical value of 10 seconds
and the average is set to 300 seconds,
then 30 spectrums are calculated for
each value in the resulting average
spectrum. Click on the arrow in the
field to list the choices.

Minimum percentage of an interval
that is valid. At least this percentage of
beats within an interval must be used
for the interval to be included. Too

histogram of dif-

ferences between
adjacent RR intervals measured as
selected heights. the upper and lower
limits are the selected heights for this
measurement. Click on each field and
type your entry to change the settings.

e Extrapolate. This field determines
what happens to the calculations when
an ectopic beat occurs. The Restart set-
ting indicates that the calculation ends
there and starts again on the next nor-
mal-to-normal RR interval. The Inter-
polation setting indicates that the RR
intervals on either side of the ectopic
will be

3D Plot

This plot presents the data from the eight
different frequency ranges (as defined in
the Spectral Analysis settings window) on
three axes: (1) Frequency, (2) Spectral
Power Density and (3) Time.

To change the amount of time displayed on
the graph, type an entry in the Hours field
and then click the Go button.
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To change the settings for Mesh X, Mesh
Y, Shaded, Contour, Hidden Lines or
Zones, click on the check box to the left of
the label, then click the Go button. A check
mark in the check box indicates that the
setting is on; no check mark indicates that
the setting is off. After you click Go, the
graph will redraw using the new settings.

To customize the axes, select Custom from
the field above the Go button. This acti-
vates the X, Y, and Z fields to the right of
it. Type the new orientation for whichever
axis you choose and then click the Go but-
ton. To return the graph to its original set-
tings, click on the arrow and select Default
from the list of choices, then click Go.

Circadian Plots

This shows the power level of each fre-
quency over time, in both absolute terms
(seconds squared) and normalized as a per-
centage. The color key for each frequency
is indicated at the top of the plot, under-
neath the data field of the frequency the
color represents.

A check mark to the left of the frequency
indicates that the frequency is plotted. No
check mark indicates that the frequency is
not plotted. To change the setting for a fre-
quency, click on the check box.

To read specific data from the plot, click
on the time-of-day of interest and a blue
marker appears. The data fields at the top
of the plot now indicate the specific read-
ing for each plotted frequency at the time-
of-day of the blue marker.

To change the number of hours displayed,
make your selection from the list of
choices in the Hours field. To display the
choices, click on the arrow to the right of
the field. Click on your choice to select it.

¢ merged and the location of a normal
beat interpolated from the surrounding
RR intervals.

e Beginning/End of frequency ranges.
Each of the frequency ranges indicated
are used to calculate the total energy in
the indicated portion of the spectrum.
This is used for all spectrum calcula-
tions. The calculated energy in each
range is calculated every 5 minutes.
The results appear in the Circadian
Plots. Note that some columns such as
the ULF may have no valid spectral
values for a 5-minute spectrum if the
default values are used. If alternate val-
ues are supplied, the resulting trend
could be valid. These values are also
used in the same manner to calculate
the range values in the spectrum sum-

mary.

The frequency ranges are abbreviated:

e ULF USRI stands for ultra low fre-
quency, with the range defined by the
user;

e VLF USR2 stands for very low fre-
quency, with the range defined by the
user;

e VLF stands for very low frequency;
e LF stands for low frequency;

e HF stands for high frequency;

¢ Total stands for the total; and

o Total USR3 stands for the total, with
the range defined by the user.

24 Hour Plot

This plots power (milliseconds squared)
versus frequency (Hz), showing the delin-
eation of each frequency range. It can be
presented on either a linear or a log scale.
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Prin ting HRYV data mal beats and the other showing the RR
interval distribution of all beats.

Report modules To include a module in the report, the

« Frequency Domain Table. Lists the check box next to the module name in the
very low, low, and high frequency data Reports window must contain a check
for each interval. Each frequency is mark. Click on an empty box to add a
reported as a percentage, for a total of check mark, and click on a check mark to
1.0 for each type of frequency. remove it. To turn all of the modules on or

off, click on the All On/Off check box

under the report module list; to change
them all again, click on the All On/Off
check box again.

¢ Normalized Frequency Domain. lists
the low (LF) and high frequency (HF)
data normalized by dividing each by the
total for that frequency.

e Time Domain Table. For each inter-
val, this lists the total number of normal
beats along with heart rate variability
calculations, including the standard
deviation of normal-normal intervals
(SDNN), the root mean square of the
standard deviation (RMSSD), the stan-
dard deviation of the standard devia-
tions (SDSD), the number of normal-
normal intervals that were greater than
50 milliseconds different from the pre-
ceding normal-normal interval (NN50),
the percentage of normal-normal inter-
vals that were greater than 50 millisec-
onds different from the preceding
normal-normal interval (PNN50), the
average normal-normal interval (RR
Mean), and the time included in the
interval.

e HRYV Time Summary. A summary of
the time domain calculations, as
described for the “Time Domain Table”
above, plus the maximum standard
deviation of normal-normal intervals
(Max SDNN), the SDANN, the SDNN
index, the HRV triangular index, the
Differential index and the Logarithmic
index. In addition, the time domain data
is plotted across the Holter period,
along with two histograms, one show-
ing the RR interval distribution of nor-
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The software generates printed reports composed of a variety of report modules that can be included or
excluded. Each module can be selected individually, depending on your documentation requirements.
Modules range from those with clerical information and Scanning Criteria settings to those with tables of
ventricular runs and detailed trends. Sample strips documenting events can be printed in standard 25 mm/
second format. Full disclosure of any interval can also be included. Some report modules are not appropri-
ate for particular patients and are not included in the list of selectable modules when you go to print the
report.

Note: All data printed on the patient report should be reviewed by a qualified physician.

Steps to create a report

The steps to create a report for the current patient are as follows:

1. Open the Report Screen and choose the List of reports that you want to include.

2. Click on “Create Report” button in lower-left. Report will be created and LibreOffice Writer
will open

3. Within LibreOffice, review report. Edit the front page, add Comments into the comment box
on first page. Save the report before closing.

4. Ifreport is final, save a PDF with LibreOffice or using the Create PDF button. Once the report

Report modules

To access the report modules that can be included in the final printed report, open the Reports win-
dow. The report modules that are available for the current patient are listed in the right half of the
Reports window. They may include:

e Patient Information. The front page of report as determined by the Report Summary selection.
It includes the Patient Information, a Summary, and the Summary text entered by user on the
View Summary window.

e List of Diary Events. Lists the time-of-day and symptom for each entry in the Diary Symp-
toms window accessible from the Patient Information window.

* Hourly Rhythm Page. Lists the rhythm type manually entered in the General table in Tables
window, using the Edit window.

e Settings Page. Includes entries from the Scanning Criteria window and their settings for the
patient.

¢ General Profile. An overview of the patient’s Holter data. The table includes interval data: the
time-of-day at the start of the interval; the low, mean and high heart rates within the interval;
the total number of beats; the total number of VPBs, VPB pairs, runs of VTAC, SVPBs, SVPB
pairs, runs of SVT, and pauses; and the amount of time analyzed in the interval.

¢ Trends. Include minute-by-minute heart rate, VPBs, VTAC beats, SVPBs, and SVT beats.
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¢ Supraventricular / AF Summary.

Tabulates the patient’s supraventricular
ectopy, including SVPB totals, singles,
pairs, and runs for each interval. Also
displays a detailed summary of supra-
ventricular run information, described
by run length and by the heart rate dur-
ing the run. AF beats, events and time
also included when it exists.

Ventricular Summary. Tabulates the
patient’s ventricular ectopy, including
VPB totals, singles, pairs, and runs for
each interval. In addition, it displays a
detailed summary of ventricular run
information, described by run length
and by the heart rate during the run.

Bigeminy. An interval table that lists
the number of runs of bigeminy by
length (in beats).

ST Episodes. List describing the
detected ST segment events during the
Holter test, along with a trend of the ST
segment measurements for each of the
three channels and the marker locations
that were used for ST segment analysis.
Each description includes:

5. Ch - the channel in which the event
occurred;

6. Onset - the time-of-day the event
started;

7. End - the time-of-day the event
ended;

8. Duration - the duration of the event
in HH:MM:SS; Note, the total dura-
tion may not equal the sum of the
column as some times may overlap
and will not be counted more than
once in the total.

9. Max HR - the maximum heart rate
during the event;

10. Time - the time-of-day of the maxi-
mum ST change during the event;

11. HR - the heart rate at the time-of-
day of the maximum ST change dur-
ing the event;

Reports

Fraont Page

List of Diary Events

Hourly Rhythm Page

Settings Page

General Profile

Trends

Supraventricular&F Summary

Wentricular Summary

Bigeminy

ST Episodes

Expanded Heart rate + 5T trend

Critical Events

Brady/Tachy Table and HRE Trend

Full-Sized Strips

Half-3ized Strips

Full Disclosure Strips

Paced Data Information

Paced Interval Histogram

Paced Summary Information

Frequency Domain Table

Time Domain Table

HREY Time Summary

Full Disclosure 30 min/page

Full Disclosure 60 min/page

Report modules in Reports window

12. mm from baseline - the maximum
change (in millimeters) from base-
line during the event;

13. mm from iso-electric - the maxi-
mum change (in millimeters) from
iso-electric during the event;

14. Slope - the slope of the ST segment
during the event; and

15. Integral - the integral (considered
to be the area between the curves)
between the ST segment trend and
the patient’s baseline trend during
the event.

¢ Expanded Heart rate + ST trend.

Presents 8 hours of minute heart rates
and 30-second ST data (for each chan-
nel) per page.

¢ Critical Events. A bar graph that

includes interval data and a representa-
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tive example for each of these signifi-
cant types of event: VPBs, VPB pairs,
VTAC, SVPBs, SVPB pairs, SVT and
pauses.

e Brady/Tachy Table and HR Trend.
An interval table that lists the number
of beats of bradycardia that occurred
and the time spent in bradycardia, along
with the number of beats of tachycardia
that occurred and the time spent in
tachycardia. Below the table is a 48-
hour heart-rate trend.

e Full-Size Strips. Presents the saved
strips in a 25 mm/second format, with
three strips per page.

e Half-Size Strips. Presents up to 14
strips per page in a non-standard for-
mat.

e Full Disclosure Strips. Full-sized strip
at the top with 6 minutes of full disclo-
sure below.

Paced Reports are only listed when Paced
is turned on.

e Paced Data Information. An interval
table that describes the pacemaker
activity during the Holter period. This
includes the total number of paced
beats, the percentage of paced beats, the
number of beats that were atrial-paced
only, the number that were ventricular-
paced only, and the number that were
paced in both the atrium and the ventri-
cle, along with capture failures, sense
failures, and inappropriate inhibition.

e Paced Interval Histogram. This
includes four histograms plotting the
number of beats versus the RR interval
following the current beat. The four
include total paced beats, sense failures,
capture failures, and inappropriate inhi-
bition. This module also includes a
heart rate trend for the Holter period,
and the definitions of the LX software’s
pacemaker labels.

¢ Paced Summary Information. This
interval table details the number of
paced beats and percentages for all
paced beats, atrial-paced only, ventricu-
lar-paced only and dual-chambered
paced beats. The information also
includes the pacemaker settings used
during analysis, as defined in the Scan-
ning Criteria window.

The following reports are only listed when
available:

¢ Frequency Domain Table. *This lists
the very low, low, and high frequency
data for each interval. Each frequency
is reported as a percentage, for a total of
1.0 for each type of frequency.

¢ Normalized Frequency Domain. This
lists the low (LF) and high frequency
(HF) data normalized by dividing each
by the total for that frequency.

¢ Time Domain Table.* For each inter-
val, this lists the total number of normal
beats along with heart rate variability
calculations, including the standard
deviation of normal-normal intervals
(SDNN), the root mean square of the
standard deviation (RMSSD), the stan-
dard deviation of the standard devia-
tions (SDSD), the number of normal-
normal intervals that were greater than
50 milliseconds different from the pre-
ceding normal-normal interval (NN50),
the percentage of normal-normal inter-
vals that were greater than 50 millisec-
onds different from the preceding
normal-normal interval (PNN50), the
average normal-normal interval (RR
Mean), and the time included in the
interval.

*Note: The Summary/Overall line at the
bottom of these reports is calculated for
the entire analysis period. Since some of
the columns represent non-linear calcu-
lations, such as standard deviations, there
is no linear operation (like average, min,
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max or median) one can do on the
column to produce the value in the
summary/overall line. For example, for
the SDNN column, the value in the
summary line will be calculated for the
entire recording, and in general, will not
be a simple average of the values calcu-
lated at each interval in the table above.

e HRYV Time Summary. This prints a
summary of the time domain calcula-
tions, as described for the “Time
Domain Table” above, plus the maxi-
mum standard deviation of normal-nor-
mal intervals (Max SDNN), the
SDANN, the SDNN index, the HRV tri-
angular index, the Differential index
and the Logarithmic index. In addition,
the time domain data is plotted across
the Holter period, along with two histo-
grams, one showing the RR interval
distribution of normal beats and the
other showing the RR interval distribu-
tion of all beats.

Full Disclosure:

e Full Disclosure. For either full disclo-
sure report, select Channels and Inter-
vals on the left-side of the reports
screen. To turn all of the Intervals on or
off, click on the All On/Off check box
under the list of applicable intervals.

Strip annotation

Strips printed in the report can include a
beat-by-beat annotation of the ECG. In the
Reports window, set the Strip annotation
field to indicate how you would like the
beats annotated. Your choices are Labels,
which are beat labels; Heart Rate, which is
a beat-by-beat heart rate calculation based
on the current-beat-to-following-beat RR
interval; RR, shows the RR interval (in

milliseconds) from the current beat to the
following one; and none - no labels.

Strip annotation || ahe|s w7 |

Labels
RF

Heart rate
Mane

Choices for Strip annotation

The beat labels consist of:

N for normal

¢ S for SVPB

e V for VPB

e A for artifact

e P for paced (A, V, or AV)
e F for AF

e D for event marker

¢ ? for questionable/unknown

Report heading

The Patient Information module of the
report includes a report heading so that you
can customize the report for your facility.
The heading consists of five lines of free
form text, with up to 34 characters per line.
To enter text in a line, click on the field
and type your entry. Click on each field in
turn and type. You can leave any line
blank.

Report heading | List |

|Super Scanners |
|One Hospital Road i
[Suite 222 |
|
|

[Micetown

Report heading in Reports window

If your address comes up automatically,
but you would like to change it for a partic-
ular patient, you can either make your
selection from the addresses you have
associated with different report configura-
tions (see Chapter 9: Configurations for
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details) or you can use the Delete/Back-
space keys to clear what is there, and then
type your entry.

To select an address from a different con-
figuration, click the List button. That
opens the Report Headings window listing
your options. Click your choice to high-
light it, then click Copy to close the win-
dow and replace the address.

Full disclosure

Full disclosure is a printout of all the ECG
recorded during the Holter monitoring
period, in a miniaturized format. Each
page is annotated with time-of-day along
the left margin.

You can print full disclosure in a variety of
formats based on the channels printed and
the amount of time printed on each page.
Full disclosure can be printed for a single
channel or for two channels together on a
page (channels 1 and 2, or channels 1 and
3, or channels 2 and 3). It can be printed
with 30 minutes of ECG per page or 60
minutes.

Determining what to print in full
disclosure

To request a full disclosure printout, select
Reports from the Review toolbar. In the
Reports window, there is a section with
settings that control full disclosure. It
includes three fields:

* Time per page check boxes. At the top
of the section are two check boxes
labeled 30 min/page and 60 min/page.
To print full disclosure, there must be a
check mark in one of these check boxes.
Click on the check box to make a check
mark appear in it; click on the other
check box to put the check mark there
and remove it from the first check box.
To eliminate a check mark, click again

on the check box.

* Channel(s) field. To indicate what
channel(s) to print in full disclosure,
select an entry from the Channel field.
Click on the arrow to display your
choices, and then click on your
selection.

+ Intervals to include. Full disclosure
can be printed for each hourly interval,
all of the hourly intervals, or whatever
combination you select. For each Holter
test, the Intervals field lists all hourly
intervals in the recording. To include an
interval in the full disclosure printout,
click on the check box next to the time-
of-day at the beginning of the interval.
Click on as many intervals as you
would like to print. To eliminate an
interval from the printout, click on the
check box to get rid of the check mark.
To check all intervals on or off, click on
the All On/Off check box below the
interval list.

Note: The time per page check boxes
control how much total ECG is printed
per page. If you choose to print two
channels of ECG, the 30 min/page setting
will print both channels during a 15-
minute time period, and the 60 min/page
setting will print both channels of a 30-
minute time period.
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Create/Open Report

Click on Create Report to open an editable
report in LibreOffice. If the report already
exists, the button will read Open Report
and clicking on it will open the current
report for that patient. Once open, you can
edit the report and Save it before closing.

Comments

You can add comments and edit the report
once opened in LibreOffice.The AutoText
feature in LibreOffice Writer can be used
to create and input comment text that you
frequently use on the reports. If comments
are added, be sure to Save your report to
save the comments.

Create/Open PDF

You will need to save a PDF to transfer the
file via LX Remote or to save it in
Archive. If a PDF file exists for this patient
the button will be labeled Open PDF. If the
patient does not have a PDF version of
their report, you can create a PDF by click-
ing on the Create PDF button from the
report screen.

You can also create a PDF
from within LibreOffice
Writer. You can do this by
clicking on the create PDF
button on the top toolbar.
Alternatively, you can save the
document in another location by going to
File > Export as > Export as PDF.

sert  Form

[ (2o

Open Acrobat

If Adobe Acro- Range

bat does not ® Al

open when sav-

ing a file, you O Pages:

can click on () Selection

“View PDF View POF after export
after Export”

from the PDF Options window that opens
during Export as PDF and the setting will
be saved.

Print Report

You can either print from LibreOffice or
Adobe Reader. In order to print from
Adobe, you may need to adjust the Adobe
Settings to ensure that they are correct for
the report, such as Print from File and
other Advance settings.

More about Reports

Status indicators

Click on appropriate box to keep track of
whether a patient’s Holter has been edited,
printed, and/or verified. Once the report is
final, you can Lock the patient so that no
edits can be made to their report or infor-
mation, without first unlocking it.

Report default set

You can modify which report modules are
selected initially by creating configura-
tions that include the report set that you
desire. You can do this under the “Report”
tab in Configurations.

Adding Logo to report

Your logo jpg, should be square and fit
into a 3x3 cm. box on the top-left of front
page. The jpg file should be named
logo.jpg and must be placed into the
bin\logo directory.

Closing the Reports window

At any time, you can save changes to the

Reports window settings, but exit without
printing the report, by clicking OK. Or, to
exit without saving any changes to the set.
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Customizing Reports

The software uses LibreOffice Write tem-
plates to produce the reports. If the user
modifies any of these templates for any
reason, NorthEast Monitoring will not be
responsible. A clean set of report templates
can be found on our web-site.

Extensive knowledge of LibreOffice
Writer and its layout capabilities is
required to make minor changes to the
templates.

For substantive adjustments, knowledge
of Python, Python appy package and xml
is required.
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7. ARCHIVE PATIENTS

Before the Patient List directory is full, you will want to archive and delete patient records to make room for
new ones. You can choose to do this manually or it can be automated to run on a regular basis.

Installing the Archive Utility

Effective with release 6.1 of HE/LX Analysis, the Archive Utility has a separate
install. The install can be found under the Holter Software on the Support >Downloads
& Document page at www.nemon.com.

HE/LX Patient Archive . : :
is accessible by going to | £ HE/LX Patient Archive Tool

the File > Open/New > File Archive Archive Auto Help
Patient List and clicking

the Archive button at I Archive Patients=>= =<Restore Patients
the bottom of the
screen. The Archive
tool has two tabs -
Archive Patients and Restore Patients.

Archive Patient Tab selected

Archiving a patient consists of two steps: 1) copy the patient to the Archive folder and
2) delete the patient from the Patient List. Once archived, if you need to go back to a
patient who has been Archived and deleted from the Patient List, you can go to the
Archive folder and restore the patient back to the Patient List.

Archive Type

From the toolbar,
you can selectan ~ HE/LX Patient Archive Tool

Archive Type. i - :

Archive Type + | Archive | Archive Auto Help |

“Full”, will copy all g : s @

patient data, includ- — JELLTL o =

ing the entire Holter V| Compression Level ¢ O Report only

recording and
report; and Archive
Type “Report only”
will save an electronic version of the patient’s Holter report, including ECG strips, but
not the recording. Only by doing an “Full” Archive, can the patient’s Holter data

be restored and reanalyzed.

Change Archive Type and Compression from toolbar
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|2 HE/LXPatient Archive Tool lo& /e

File Archive Archive Auto Help

(Aot Patts>> | <Restore Patns |

Actve Patient Lst - Archived Records

Search Patients ’7 : Search Pafients ’7

Mo Name DOB. 0# | Analyst |Datere..| Analyzed| P | V [ HIS| L |Opene. Type Name DOB ID# Analyst |Daterecord., Analyzed
1/3mith, Susan 20001201 314159 2004-1... [2007-11. i U Report |Smith Susan— |2000-12-01 314159 2004-10-04 {2007-11-10
2/White, Stanley  [1945-07-30 |20000 20094.. 0ts02..| [ ji u g@ Report [White, Stanley  11945-07-30 |20000 20091208 20160217
3|Suarez, Josephi..|1955-1201 0200 20154 [2015-10..| [ i U g@ Report |Emerald Laura [1934-07-05 (012345 201540721 [2015-11-23
4Foster Kevin ~ [1967-04-07 1793847 . 0154, 0tE0.| [ i U g@Repun Foster Kevin ~ [1967-04-07 (17938479709 20154001 2015-10-08
SlEmerald, Laura [1934-07-05 (012345 20154... 201511 | [ i - g@Repon Suarez, Joseph... 1955-12-01 (0200 20151001 [2015-10-08
BlAll, Masan 10031212 3456 100641... 200801..| [ ji U :
10/Remote, Patty 207794 M6 201602, [ ji N
21/Crabby, Sleep (30054 onor0. 2ote0e. | | | O | O

Archive Patient Window

Compression Level

Increase the compression level to save disk
space when archiving. The more com-
pressed the file, the longer archiving will
take.

Archive Patients Tab

The HE/LX Patient Archive Tool will ini-
tially open with the “Archive Patients” tab
selected. Once opened, all patients who can
be archived will be highlighted in blue. A
patient is highlighted in blue when:

1. They have been analyzed

2. They have a PDF report

3. They have never been archived previ-
ously, or their information has been
updated since they were last archived.

If you want to override the highlighted

patients, you can hold the Shift-key and

click on any directory in order to manually

select or deselect it. When finished, click the

“Archived Selected Patients” button at the

bottom of the screen and the selected

patients will be copied to the Archive folder.

Note: If a Patient is opened and viewed,
but not updated, the system will perceive
this patient as being updated and show that
the patient needs to be archived again. To
ensure that this does not become a problem
for you, be sure to wait to archive a patient
until you are sure that they will most likely
not be viewed or reviewed again.

Delete Patient Records

Once archived, you will want to delete the
patients from the Patient List in order to
make room for new patients. The Archived
check box, labeled “A” on the Patient List,
will show you which patients have been
archived and can be deleted at this time.

Customizing Screens

Just like the
= : - primary
¥pe Update Columns Patient List,
ieport : you can cus-
leport Smith, Susan ¢ tomize any
of the

archive lists
by changing, moving and resizing columns.
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| £ HE/LX Patient Archive Tool

File Archive Archive Auto Help

|/ Archive Patients=> |/ =<Restore Patients

lactive Patient List Archived Records

Mo. Mame m:: Opened.. :
1|Smith, Susan 3141549 <
2|\White, Stanley (20000 B Type Mame Dy O
3|Suarez, Josep...[0200 =| =|Full Ali, Masaon 1993-12
d|Foster, Kevin 17938479709 Full Crabby, Sleep
5|Emerald, Laura (0123245 [ | : Report Emerald, Laura |1934-07
Rlali Mason 2ARA AReport Foster, Kevin 1967-04
Restore Patient Tab

Select columns by right-clicking on any of
the column headings and then on “Update
Columns.” You can also search on each
list by typing into the Search box at top of
the screen.

Restore Patients Tab

You can only restore patients when a Full
Archive type has been performed.

To restore a patient that has been archived
and deleted from the Patient List, select the
Restore Patients tab on the HE/LX Patient
Archive Tool. When selected, it will be
blue. You will now see a searchable list of
all archived records on the right. Select the
archived patient you want to restore on the
right, and an empty patient directory on the
left. Then click the Restore Selected
Record at the bottom of the screen to copy
the patient back to the Active Patient List.

<<Restore Selected Record

Restore “Full” Archived Records

Delete record after Restore

At this time, if you want to delete the
Archived record of the patient you just
restored, you can go to the toolbar and
select Archive > Delete Selected Archive
Record.

HE/LX Patient Archive Tool
g | Archive

Archive Auto Help

nts

=

€ Archive Type )

v Compression Level "

Delete Selected Archive Record ¥ Delete Archived Reco

Restore Patient Tab

Report only Archive

If you archived
patients using the
“Report Only”
option, you will not be able to restore those
patients as they no longer have the ECG
file. Instead, you can View the patient’s
report by clicking on the View button at
the bottom of the screen.

View Report
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Auto Archive

The Archive process consists of two
actions, both of which can be run automat-
ically on a schedule or initiated by you by
clicking the Auto Archive button from the
Archive Window. The two pieces to
archiving are:

1. Copy a patient from the Patient List to
Archive after a defined number of days
that the patient has a report created or
modified

2. Delete the patient from the Patient List

after a defined number of days after
the patient has been Archived and no
subsequent changes to the patient have
been made.

Scheduling Auto Archive

You can schedule the Archive program to
run in the background. You can do this by
setting up a Scheduled Task from Control
Panel > Administrative Tools. The com-
mand that should be entered where “c:nm”
is the location where the HE/LX Analysis
is installed:

Auto Archive and Archive.ini

An Archive.ini file is included in the
installation in the bin directory. The direc-
tory where the archived files are saved can
be changed here. Additionally, the number
of days criteria used to Archive and/or
Delete patients can be found and edited in
this file. They are:

¢ AutoArchiveDays - the number of days
after a patient has a report created that
the patient will be copied to the archive
directory. Make -1 to turn this feature
off.

¢ AutoDeleteDays - The number of days
after a patient is archived that the
record will be deleted from the Patient
List. Make -1 to turn this feature off.

c:\nm\java\jdk-14.0.1\bin\java.exe -jar c:\nm\bin\archive.jar -auto

Optionally, you can use the Archive.ini file
in the bin directory to modify the auto
archive criteria.

Create Basic Task Wizard

(®| start a Program

Create a Basic Task
Trigger Program/script:

Daily
Action

Finish Start in (optional):

Scheduled Task Example

chnmbjavaibinijava -jar c\nmibin\archivejar -auto

Add arguments (optional):

Browse...
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You can customize certain parts of the HE/LX Analysis software to better suit the needs of your facility.
The options range from entering the names of physicians who order Holter tests - so that you don’t have to
type them in each time - to which Review window you want to come up automatically at the end of analy-
sis.

.

Preferences Preferences (=]
WindOW [v] Draw grid

To open the Preferences window, select Automatically update tables

File > Preferences. (] Print in color

[_] save new Physician or Interpreting physician

Draw grid

[ ] Faxable report
You can choose -Wheth‘er or not there is Annotate [Heart rate <]
a background grid behind the Expanded
strip displayed in the Page window. ST Measurement |ST segment A
Click on the Draw grid check box to After analysis show |Page |~
change the setting. A check mark indi-
cates that a light grid will appear. No Saved strips
check mark means that the grid will not Single view
appear.

Default sort ﬂ

Automatically update tables

A check mark should appear in the
check box so that the software automat-
ically updates counts, tables and strip
labels after you relabel a beat, template
or bin in any of the Review windows. If

| Physicians
|
|

it does not automatically update, you | Configurations
|
|
|

Interpreting physicians

Summary phrases

must manually run an update after mak-
ing changes.

Beat Label Edit

Note: If this setting is off you must jcications bt

have the toolbar turned on, as a
blinking red Update button will
appear in the lower toolbar when

an update is required. To manually |
run an update after making Preferences window
changes, click on the blinking red

button or select Review > Update.

Medications Edit

0K H Cancel
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Save new Physician or
Interpreting physician

Allows the software to ask you whether to
add a new or interpreting physician name
to the appropriate list when you close the
Patient Information window after typing a
new name in either field.

Annotation

Select how the beats in any on-screen,
expanded strip should be labeled with a
beat-by-beat heart rate calculation or RR
interval length. The annotation refers to
the RR interval starting at the R-wave
under the label. Click on the arrow in the
field to display your choices. Click on your
choice to select it.

ST measurement

ST segment
analysis can be
performed with
the ST seg-
ment measure-

| " ment made at
the position of
either of the
Positions of ST markers two right-most
ST markers.

The middle marker identifies the J-point
and the one at the far right is the ST seg-
ment marker. Indicate in this field which
marker should be used for ST segment
analysis. Click the arrow in the field to dis-
play your choices, then click your choice.

After analysis show

Allows you to

determine which Critical Events -
window is dis- Bin
played upon the Page

Critical Events
Saved Strips

completion of
analysis. Your

choices include Trands

any of the Tahles

Review win- Repors

dows and the Calibration

Reports window. Choices for display
To change the

setting, click on the arrow in the field to
display the list of choices, then click on
your selection.

Saved Strips Default View

Saved Strips Default View allows you to
set up how the Saved Strips screen will
look initially after analysis. If “Single
View” is checked, you will see a single
strip; uncheck it to see multiple strips ini-
tially. Once you open the screen, you can
modify these settings for each patient as
you choose.

Physicians and Interpreting
Physicians windows

Physician and Interpreting physician
entries can be entered, edited and deleted
here, allowing you to make a selection
from a list instead of typing the physician
names for each patient in Patient Informa-
tion. Additionally, if you turn on the Save
new Physician or Interpreting physician
Preference setting described earlier in this
chapter, you can add new names to the list
automatically when entering new physi-
cians in the Patient Information window.

To create an entry, click on the “Add new
item” button, go to the new line and enter
the item. Hit the Enter button on the key-
board to save and add more if you like.
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To exit without saving changes, click Can-
cel. To edit just click on a line and then

update, and to delete an entry, click on the
trash can next to line you want to remove.
Click OK to exit the screen when finished.

Beat Label Edit

This screen allows you to customize the
list of labels that appear on Strip Labels,
Saved Strips and the final report. Double-
click on the No. of the label that you want
to edit on the column labeled “Editable
custom label,” edit and press Enter.

Note: Changes to labels must be made
carefully because the meaning of the
label MUST NOT change. For example,
when the system calls a beat ventricular,
it uses the VPB label when saving strips
for the report; you can change the text to
read VE instead, but not SVPB or BBB,
or your report will be incorrect.

Indications and Medications Edit

This window is for customizing the indica-
tion and medication lists on the Patient
Information screen.

Configurations

Click this button to launch the Configura-
tion program that allows further customize
the HE/LX Analysis software settings.
Details appear in Chapter 10: Configura-
tions.

Updating Software

If you are upgrading from an older version
of the software, LX Analysis (5.2 or later),
you should be able to copy and paste the
old info.ini file into your new location.
(See above) The old info.ini file will either
be found in the directory of the old install,
if you installed to a new directory; or in
bin_backup if you installed your software
in the same directory.
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The Configuration program (also called the Configurator) allows you to customize certain aspects of the
screen displays, analysis and reports. With careful attention to detail, you can establish report formats that
are specific to a physician or automatically change dozens of analysis settings for a particular patient type
(e.g., patients with pacemakers). Each separate customized format is called a configuration.

You access the Configurator with the HE/LX Analysis program running via the File > Preferences
Screen. At the bottom of the Preferences window, click the Configurations button. The main Config-
urations window opens.

Configuration window

The main Configuration window opens with a listing of all current configurations of your software.
Each should have a unique name. To start, you have been supplied with a Default Holter configura-
tion and it cannot be edited, but it can be used during analysis, or as a starting point for a new config-
uration. You can delete all but the “Holter Default” configuration if you want to do so. If you want to
bring back default configuration after it has been deleted, you can press the “Restore” button.

To edit the Custom or another configuration, click on the name associated with the configuration you
want to change, and then click the Edit button.

[A] HE/LX Analysis Configurator - 0o X
File

Type of Analysis/Report - C:inm61ibiniseti

Default Holter
ustom

Copy Edit Delete Restore S...

Main Configuration window
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To create a new configuration, click on the
name associated with a configuration simi-
lar to the one you want to create, and then

To display the fields in a particular folder,
click on each of the tabs for that folder:

¢ Main - Includes the name or descrip-

click the Copy button.

To delete a configuration, click on the
name associated with the configuration
you want to eliminate, and then click the
Delete button.

To restore the default configurations, click
on the Restore button. Use this cautiously
as any configurations you created will be
lost.

Configuration folders

A configuration consists of a series of fold-
ers with tabs. Each folder contains the con-
trols for a particular window or portion of
the HE/LX Analysis software. Within the
folders for a configuration, an entry in a
field automatically populates that field for
a patient when you select the configuration
or “Type of Analysis/Report”.

tion of the configuration, which appears
in the Type of Analysis/Report list; the
physician’s and interpreting physician’s
names associated with the configura-
tion; the scan number; hookup techni-
cian; and analyst.

When you create a new configuration
by using the Copy button, the Descrip-
tion field in the Main folder reads
***New Type***. Be sure to type a
new name for the configuration in the
Description field to differentiate it from
others you create. This is the name that
will be visible on the Patient Informa-
tion as Type of Analysis/Report.

The Main folder contains the Scan #
field which controls the auto-sequenc-
ing of the Scan number in the Patient
Information window. To have the sys-
tem automatically increment the scan
number for each patient, enter $seq in

@ Custom (Chnmb1\bintset\s000.ini)

Page/Calibration/Critical Events/Superimposition r Trend/Lorenz Plot |

Scanning Criteria r Spectral Settings r

Spectral HRV

r What Strips to Auto Save

Main r Diary r How Often Strips Auto Save r

Miscellaneous

r Report r Research r Rhythm |

Description [Custom

Physician |

Interpreting physician |

scan# |

Hookup tech
Analyst

Patient Type | Holter

|v|

Channels Recorded

Recorder Model |

Invert

Hide

Channel 1

Channel 2

==

Channel 3

oK | | Cancel

Configuration folders
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the Scan # field; to include the date and/
or time-of-day in the Scan # field, enter
$date or $time, respectively. Use what-
ever order you want the scan number to
follow. Also, be sure to turn on the
“Assign date and time to Scan #” fea-
ture in the Preferences window.

The Main folder includes a field called
Patient Type. At this point, only
“Holter” is supported.

The rest of the folders are:

Diary - Different diary entries can be
added, and diary entries can be replaced
with other text or deleted singly or all
together. The diary entries appear in the
drop-down list of choices in the Symp-
tom field in File > Patient Information
> Diary.

How Often Strips Auto Save - This
controls the settings that come up auto-
matically in this window in Settings >
How Often Strips Auto Save.

Miscellaneous - This controls the beat-
by-beat annotation, the ST segment
analysis location in the Preferences
window, and some advanced file nam-
ing fields.

Report - This controls the default
report set for the configuration. Addi-
tionally, you can customize the default
report heading, front page, strip annota-
tion, full disclosure, report summary,
and saved strips fields in the Reports
window. You can also change the com-
pany’s name and address.

Rhythm - Different rhythm types can
be added, and rhythm types can be
replaced with other text or deleted.
Rhythm types appear in the Comment
field in Tables > Edit. They do not
appear in the printed report.

¢ Scanning Criteria - This controls the
automatic settings that appear in the
Scanning Criteria window. The window
is accessible from the Patient Informa-
tion window by clicking Settings >
Scanning Criteria or from the main
Holter menu under Settings > Scanning
Criteria.

¢ Spectral Settings - This controls the
automatic settings that appear in the
Spectral Analysis window. The window
appears when you select Settings >
Spectral Analysis.

¢ Spectral HRYV - This controls the the
heart rate variability plots in the HRV
menu.

¢ What Strips to Auto Save - This con-
trols the settings that come up automati-
cally in this window in Settings > What
Strips to Auto Save.

¢ Page/Saved Strips/Critical Events/
Superimposition/Calibration - This
controls the appearance of some of the
Review windows, the settings in some
fields, and whether the window initially
appears in Expanded mode.

¢ Trend/Lorenz Plot - This controls the
Type that is initially displayed.

Saving a configuration

For each configuration you create or edit,
make changes in as many folders as you
need to. When all folders reflect what you
want to associate with that configuration,
click the OK button at the bottom of the
window. Your new configuration will be
saved and the window closed; the main
Configurator window then appears.
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Exiting from the Configuration
program

To exit from the Configuration program,
click on the red Close button in the upper
right corner of the window.

Using a configuration

The configuration is used when you start a
new Holter test. When creating a new
patient, the list of Configurations appears
in the Type of Analysis/Report field on the
Patient Information window.

By choosing a configuration, all of the
items that were defined in the configurator
will be applied automatically to your
patient. Any of these settings can then be
updated for your patient if you choose to
do so, before or after analysis.

At any time you can go back and change
the Type of Analysis/Report for a patient,
but keep in mind that all settings will be
reset to the new configuration and any
editing you have already done to the
patient will be lost.
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UTILITIES & SET UP

Licensing

There are two options for licensing the software: 1)a permanent license that allows for
unlimited number of uses of the software and 2)Pay-per-Use (PPU) license that counts and
monitors the number of Holter files that have been analyzed by a user. All installations,
regardless of license type, must include a license.ini file in the bin directory. When the soft-
ware is running, the type of license or Uses Remaining (for PPU), is displayed at the bottom
of the main screen.

For Permanent licensing, a physical HASP software key must be
plugged into your PC or your network. When licensed to do so, a
key can be shared by many users. The license file, license.ini, must
be installed in the bin directory on each PC where HE/LX has been
installed.

For Pay-per-use (PPU) licensing, Contact NorthEast Monitoring Sentinel HASP key
Technical Support for information on our PPU licensing program.
Email to support@nemon.com or call [+1] 978-461-3992 option 1.

See Appendix B for more information on Network installations as additional setup is
required for all license types.

Utilities
When installing the software, two additional utilities have been installed with the HE/LX

Analysis Software: 1) HASPFinder and 2) Settings. Both utilities have been installed under
“NorthEast Monitoring” programs list.

The HASPFinder Utility.

e The HASPFinder utility will look up ASPEinder test

LesT program

and show you any NorthEast Moni-
toring HASP key that is visible to
the computer. The utility will also
show you the license.ini file and if
the license.ini file matches any of the
HASP keys plus:

e For PPU licensing, the HASPFinder
utility will also show you the Use
Count and Limit for you license.

e If your software has a Customer

Code that can also be seen via the
HASPFinder utility.
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The Settings Utility

In Settings, you can enter the names of both your
facility and the primary user of your Holter soft-
ware, along with five lines for the name and
address that appear in the Reports window when
you print a Holter report.

e

Company |

@ HE/LX Analysis Settings =z
|
|

User name |

Language |Eng|ish |v|

Holter Report heading

Number of patients |2p

| Go to Demo Patient | | Restore Demo Patient |

Settings window

Changing Language

The drop-down box will show the list of lan-
guages that are currently supported in the soft-
ware. To change the language used throughout
HE/LX Analysis, make your selection from the
drop-down menu.

Number of Patients

To change the number of directories stored on the
Patient List, you can enter a different number
here. If you choose to increase the number, addi-
tional directories will be created, but if you need
to decrease the number of directories, you will
need Windows Explorer to do so, but be sure that
the directories you are deleting are either empty or
the patient data has already been archived.

NorthEast Monitoring recommends that you have
no more than 500 patient directories, as when
more than 500 exist, the speed of the system may
be compromised. See Chapter 8 for more informa-
tion on Archiving patient directories.

Go to and Restore Demo Patient buttons

If there is ever a time that you are unable to start
the software because of a problematic patient
record, you can use the Go to Demo Patient button
to open the software. If for some reason the demo
patient has been deleted, you can first restore it
using the Restore Demo Patient button.

Patient Directories

Starting with Holter LX Analysis 5.4e, all patient files
must exist in a single directory. The [PatientParentDir]
denotes the directory location and size and can be
found at the top of the h4w.ini file. By default, the pat
directory will be created in the local application direc-
tory. You can modify it to meet your needs. Below are
some examples of how it can appear:

[PatientParentDir]
c:\nm\pat, 100
;default example

[PatientParentDir]

c:\nm60\pat, 30

;default when software installed in other than nm direc-
tory, for example, nm60

[PatientParentDir]
\\shared dir\nm\pat, 30
;Network example

Permanently Delete Patient Directories

If for some reason you would like to reduce the
number of patient directories, you must first delete
the patient records in the directories you will
delete. You can do this by going to the Patient
List, selecting the patients, and then clicking the
Delete button. You will then need to go to the
Settings Utility window to reduce the number of
patient directories, and then use Windows
Explorer to delete unwanted directories perma-
nently. Use the Archive function to save patient
directory prior to deleting directories.
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LX Remote Interface

The HE/LX Analysis software is able to receive
Holter files and send report files through the LX
Remote web-based system.

Note: Please ask your technical professional for
assistance in setting this up. Also refer to the LX
Remote manual for more information. All
manuals can be found at www.nemon.com.

Plugins

The HE/LX Analysis software comes with plugins
that enable the HE/LX Analysis and the LX
Remote systems to work together. In order for
these plugins to function, they must be copied
from c:\nm\bin\Plugins_Available to
c:\nm\bin\plugins, or wherever your HE/LX soft-
ware is installed.

The plugins for Remote are:
e remotereceiveplugin.jar
¢ reportsendplugin.jar

¢ narpstatusbarplugin.jar

remotereceinveplugin.jar

This plugin enables the Remote Receive screen,
which can be found from the Patient List.

[ 0|Demo Patient [

| Archive | Remote Receive |

reportsendplugin.jar

This plugin enables a button which allows you to
send reports back to your remote users automati-
cally. This button will be visible at the bottom of
the Patient List.

Send Report Remotel |

Delete

narpstatusbarplugin.jar

This plugin enables
NARP messaging
which tells you if the
NARP program has
stopped running, and when it is running, how
many new files are available.

Remote - 11 file(s)|

h4w.ini file

In addition to the plugin being installed in the
proper directory, the following variables must be
correctly set up in the h4w.ini file. If any of the
plugins are not working as expected, you may one
to check these:

The report upload directory. The location where
the Reports directory is located for sending reports
back to your users via the NARP. This should
appear under the [NARP] section:

uploadDir = c:\nm\reports

The NARP status file. The name and location of
the NARP status file that indicates that the NARP
is running. In the [Settings] section:

narpstatusfile =
c:\nm\narp\NARP_Status.ini
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Interface for Foreign (not
NorthEast Monitoring) Data

Formats

The HE/LX software can be used to process ECG
data from foreign recorders that use their own
unique file formats. To accomplish this one con-
verts the foreign data into an intermediate binary
format (IBF) which can then be processed by HE/
LX Analysis.

The license for the HE/LX Analysis system
must include the “Data” option. Note that this
requires the PPU (Pay-per-use) license option.

The following steps are necessary to enable a for-
eign recorder interface:

1. The plugin must be enabled. The plugin
foreignrecorderimportplugin.jar must be copied
from c:\nm\bin\Plugins_Available to
c:\nm\bin\plugins.

2. The foreign data must be converted to the
IBF format. This conversion utility is the respon-
sibility of the vendor supplying the foreign data.
The IBF data format is defined as follows:

2.1 Up to three (3) channels of Holter data are
supported. For each channel a separate binary
file must be supplied. The files are to be named
flashc0.dat, flashcl.dat and flashc2.dat for
channels 1, 2, and 3 respectively. If fewer chan-
nels are to be processed, only generate the first
N files as required. These files are to be placed
in the \<nm>\bin\tmp directory (replacing
<nm> with the actual installed location). The
data must be in the form of 16-bit binary values
with the least significant byte first (little
endian).

2.2 The least significant bit must be equivalent
to a voltage at the electrodes of 12.5 micro-
volts.

2.3 The sampling rate must be 180 samples per
second.

2.4 The utility which produces or copies this
data must be callable at the command line in a
Windows-based system.

3.Pat.001 File. If additional information, such as
patient name or patient ID, are to be passed to the
HE/LX Analysis program at the same time as the

ECG data, a file called pat.001 must be generated.

3.1 This is to be done by using a “blank”
pat.001 file from the same version of the HE/
LX Analysis system which will be used for
analysis.

3.2 To generate this system file, select “File-
>New” and select an empty patient directory
and note the path to this directory but do not

select it yet, exit the new/open window.

3.3 Copy a flash.dat file into the empty direc-
tory. This can be the file from c:\nm\pat\demo.
Again in “File->Open/New” select the patient
directory found previously.

3.4 Exit the program and get the pat.001 file
which was generated in the directory selected
above.

3.5 Edit the line in the pat.001 file:
IgnoreFlashFile =0 to
IgnoreFlashFile =1

3.6 Edit the DateRecorded (start date of
recording) and TapeTimeBeg (start time of
recording) in the following format:
DateRecorded = 12-Dec-2012
TapeTimeBeg =12:12:00.000

3.7 You may also want to enter other recording
identification into the pat.001 file before ana-
lyzing.

PatientNameLast = (optional)
PatientNameFirst = (optional)
ScanNo = (optional)
IdNo = (patient ID)
RecorderNo = (optional)
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3.8 If there are diaries for the recording, they
can be added to the [Diary] section with the time
being the offset from the beginning of the
recording. An example:

[Diary]

10:46:06.367 Event

10:53:03.900 Rapid HR

11:33:03.811 Palpitations

4. A batch file must be created which does the fol-
lowing:

4.1 Calls the vendor supplied conversion utility
to generate the tmp\flashcx.dat (IBF) files.

4.2 Places the pat.001 file in the selected patient
directory. The first argument to the batch file,
which is accessed as %], is the path to the cur-
rent patient directory.

4.3 Places a "dummy" flash.dat file in the
selected patient directory. This file must be a
valid flash.dat file but will not be used for analy-
sis. The file in \nm\pat\demo can be used.

4.4 Calls the utility unpackdc.exe as follows
(missing flashcx.dat files are replaced with - ):

unpackdc %1\datacard.dat tmp\flashc0.dat
tmp\flashc1.dat tmp\flashc2.dat 3

4.5 The batch file may be called userimport.bat
and must be in the c:\nm\bin directory.

5. In the c:\nm\bin\h4w.ini file a line must be added
after the [Settings] header and before the next [ |
section. The line is:

FRIImportCommand=userimport.bat $PatientDirectory

with the userimport.bat name replaced by the batch
file name actually used above.

6. If the sampling rate and/or scaling of the data
cannot be provided as specified, then it is possible
within a limited range to have the unpackdc.exe
utility make some adjustments. This is only recom-
mended if the LSB of the data is less than 12.5

micro volts or the sampling rate is greater than 360
samples/second. Run the unpackdc.exe utility at the
command line with no arguments to view the full
set of instructions.

7. To start processing the data:

7.1 In the HE/LX Analysis program open File-
>0Open/New.

7.2 Select an unused
patient data slot and the
"Import ECG" button
which has been enabled.

Import ECG

7.3 Clicking on the "Import ECG" button will
cause the batch file from above to be run and
will then open the Patient Information screen to
allow processing to be started.

8.Sample / example batch file

Here is a sample of the batch file. It assumes that a
recorder manufacturer created a callable executable
named TZMM.exe instead of userimport.bat.

TZMM.exe -¢ 1 -f helx -1 tmp\tz -0
tmp\flashc0.dat

TZMM.exe -¢ 2 -f helx -1 tmp\tz -0
tmp\flashc1.dat

TZMM.exe -¢ 3 -f helx -1 tmp\tz -0
tmp\flashc2.dat

unpackde %1\datacard.dat
tmp\flashc0.dat tmp\flashc1.dat tmp\flashc2.dat 3

copy \nm60a\pat\demo\flash.dat %1 /y

copy import_pat.001 %1\pat.001

In this case, the h4w.ini file should be modified as
follows:

FRIImportCommand=TZMM.bat $PatientDirectory
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Remote Receive for PPU

A special feature allows you to create
patient directories in advance so that you
can receive recordings remotely and assign
them into the patient folders using the
Remote feature.

This can be accomplished by:

1. Add variable HISRemoteReceive = 1
under [Settings] in h4w.ini.

2. Populate empty patient directories
with an externally generated pat.001
file.

Then, using Remote Receive, copy the
remote files into the populated patient
directories.

HIS Import Option

Hospitals can choose to save LX Remote
flash.dat files to pre-loaded patient directo-
ries, by inserting the following variable
into the h4w.in file under [Settings]:

HISRemoteReceive = 1

If this option is chosen, then Remote
files can only be saved in pre-populated
patient directories that are loaded via an
external process.

HIS Export

HE/LX Analysis includes an interface to
your hospital information system (HIS).
Once a patient is completely analyzed and
a PDF report has been saved, the user can
save a copy of the patient data and final
report in a location for your hospital infor-
mation system to retrieve.

Once HIS Export is set up, a button can be
found at the bottom of the Patient List. The
button will be enabled only when a patient
has a PDF report to copy.

HIS Export Setup

The HIS export plugin - hisexportplu-
gin.jar - must be copied into the Plugins
directory (from Plugins_available) in order
for the HIS Export button to be visible on
the Patient List.

Additionally, the following variables must
exist in your h4w.ini file and need to have
the correct paths in order for the HIS
Export to function properly:

HISExportCommand = cmd /c
rephis.bat "$HISExportPath"
HISExportPath = c:\HIS Transfer\Pat-
$IDNO-$DateRecorded-$Current Time-
Stamp

The HISExportPath determines where the
files are saved. As per above, the files will
appear in the user’s ¢c:\HIS Transfer direc-
tory. Each file name will begin with the
following format, Pat-SIDNO-$DateRe-
corded-$CurrentTimeStamp, unless you
choose to do otherwise.

The HIS Export Process

The user creates the HIS files by going to
the Patient List, clicking on one or more
patients, and then clicking on the HIS
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Export button. The HIS Export button will only be
enabled if the patients selected have a report to
export. Three files are created for each patient dur-
ing this process:

3. cmp - the existence of this file tells you that
the other files are ready to be retrieved.

4. pdf - the patient’s Holter report

5. txt-atext file in an xIm format with the
patient data.

The File Format

The txt file includes the following data elements:

PATIENT INFORMATION

This information comes from the Patient Informa-
tion window. Most of this information has been
entered by the user.

¢ PatientName

¢ PatientNameFirst
¢ PatientNameMI
¢ PatientNameLast
¢ Physician

e DOB

¢ ScanNo

e IdNo

e Age

e AgeUnit

e Sex

¢ Gender

e RecorderNo

e Analyst

e HookupTech

¢ PhysicianInterp
¢ Indication

e Medication

* height

e heightunit

e weight

e weightunit

e bmi

e Recordermodel
¢ NoChannelsRecorded

SUMMARY INFORMATION

e DateRecorded

¢ DateProcessed

e TapeTimeBegin

¢ Minimum-Heart-Rate
¢ Mean-Heart-Rate

¢ Maximum-Heart-Rate
¢ Total-Time-Analyzed
o Total-Beats

o GP-Total-Time-Recorded
¢ GP-Heart-Rate-MEAN
e GP-Runs-VT

e GP-Runs-SVT

¢ GP-Pauses

¢ GP-Longest-PauseRR
¢ GP-Notes

¢ Percent-Artifact

PACED INFORMATION

e Total-Beats-Paced

¢ Percent-Beats-Paced

¢ Beats-Atrial-Paced

¢ Percent-Beats-Atrial-Paced
¢ Beats-Vent-Paced

¢ Percent-Beats-Vent-Paced
¢ Beats-AV-Paced

¢ Percent-Beats-AV-paced

PACED DATA INFORMATION

¢ Paced-Capture-Failure
¢ Paced-Sense-Failure
¢ Paced-Inhibition

PACEMAKER TYPE SETTINGS

¢ Pacemaker-Type

e Minimum-Programmed-Heart-Rate
e Maximum-Programmed-Heart-Rate
e Maximum-Ventricular-to-R-interval
¢ Maximum-atrial-to-R-interval

SUPRAVENTRICULAR SUMMARY
¢ Total-SVPB

e SVPB-Single

e SVPB-Pairs

NorthEast Monitoring, Inc.

NEMMO027-Rev-S

Page 89 of 99



HE/LX Analysis Operator’s Manual Licensing, Utilities & Set up: HIS Export

e Total-SVT-Events VENTRICULAR SUMMARY

» Total-Beats-In-SVT ¢ VENT-Runs-VT

¢ SVPB-run3-greater ¢ VENT-Beats-VTAC

¢ SVPB-run4-greater ¢ VENT-Total-Beats

e SVPB-run5-greater e VENT-single-vpb

e SVPB-run69-greater o VENT-Pairs

¢ SVPB-runl0-greater ¢ VENT-run3-less

¢ SVPB-Beats-Greater ¢ VENT-run4-less

¢ SVPB-long-beats o VENT-run5-less

¢ SVPB-long-time ¢ VENT-run69-less

* SVPB-long-BPM e VENT-runl10-less

e SVPB-fast-beats e VENT-beats-less

¢ SVPB-fast-time ¢ VENT-run3-greater

* SVPB-fast-BPM e VENT-run4-greater
e VENT-run5-greater

A FIB ¢ VENT-run69-greater

« AF-Beats ¢ VENT-runl0-greater

« AF-Events ¢ VENT-beats-greater

« AF-Time ¢ VENT-long-beats

o AF-Percent ¢ VENT-long-time

o AF-long-beats * VENT-long-BPM

« AF-long-time ¢ VENT-fast-beats

« AF-long-BPM ¢ VENT-fast-time

* AF-fast-beats * VENT-fast-BPM

e AF-fast-time

» AF-fast-BPM SETTINGS

e SET-Tachycardia-rates-greater
SET-Bradycardia-rates-less

o SET-Pauses-greater
SET-Categorize-SVT-greater
SET-Categorize-VT-greater
SET-Signal-Quality
SET-Number-Channels-Processed
SET-Primary-Channel
SET-Alternate-Channel
SET-Automatic-Channel-Selection
SET-Automatic-ST-marker-selection
SET-Process-ST-Events
SET-Artifact-Filter
SET-Narrow-QRS
SET-Extra-Dead-Time
SET-Label-SVPB-prematurity
SET-Label-Early-VPB-prematurity
SET-Minimum-AF-Peak-HR
SET-Minimum-AF-time

BRADYCARDIA/TACHYCARDIA TABLE

» Beats-Bradycardia

¢ Time-in-Bradycardia

¢ Beats-Tachycardia

¢ Time-in-Tachycardia

¢ Perc-Beats-Bradycardia

¢ Perc-Time-in-Bradycardia
 Perc-Beats-Tachycardia

¢ Perc-Time-in-Tachycardia

BIGEMINY TABLE

* Bigeminy-Beats

* Bigeminy-3Beats

* Bigeminy-49Beats

¢ Bigeminy-1024Beats
¢ Bigeminy-25Beats
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e SET-SVBs-Disabled

¢ SET-Maximum-Analysis-Duration
e SET-Interval-Size

e SET-Lead-Label-1

e SET-Lead-Label-2

e SET-Lead-Label-3

ST EPISODE TABLE

e ST-EPISODE-Elevation-MM-Baseline

e ST-EPISODE-Elevation-MM-ISO-ELEC
e ST-EPISODE-Elevation-Integral

e ST-EPISODE-Depression-MM-Baseline

e ST-EPISODE-Depression-MM-ISO-ELEC
¢ ST-EPISODE-Depression-Integral

TIME DOMAIN CALCULATIONS

e SDNN-ms

e Max SDNN-ms

e SDANN-ms

e RMSSD-ms

e SDNN index-ms

e NN50 count

e pNN50-percent

e HRV triangular index
¢ Differential index-ms
e Logarithmic index
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Types of heart rates
A variety of heart rate calculations are made by HE/LX Analysis. They include:

Current heart rate
Minute-by-minute heart rate
Beat-by-beat heart rate

Mean heart rate in intervals

Mean heart rate for Holtered period
Second heart rate

AF Heart rate

Heart rate strips

Current heart rate

This is a complex function that takes the current beat and the beats preceding it into account. This
weighted average follows these rules:

1.

If the differences between the adjacent beats of the preceding four RR intervals are no more than 12
percent of the average RR interval for the previous beat and the beats are all normal, then the new
average RR interval is the simple average of the previous four RR intervals.

If the previous four RR intervals were NOT bigeminy, VTAC or SVT AND the current RR interval is
within 25 percent of the previous average AND the previous two beats were not ventricular AND the
previous 10 beats were not supraventricular, then the new average RR interval is 1/8 of the current
RR interval plus 7/8 of the previous average.

If the previous four RR intervals were NOT bigeminy, VTAC or SVT AND the current RR interval is
not within 25 percent of the previous average OR any of the previous two beats were ventricular OR
any of the previous 10 beats were supraventricular, then the new average is 1/32 of the current RR
interval plus 31/32 of the previous average.

If the previous four RR intervals were bigeminy, VTAC or SVT, then the average RR interval is
changed by 0.000087 seconds. It is increased if the current interval is longer than the previous inter-
val, otherwise it is decreased.
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Once the current average RR interval is determined, the current heart rate is calculated as 60 divided by
the current average RR interval, that is, current HR = 60/(current RR interval).

The current heart rate is used as the heart rate that appears in the heart rate data field for any displayed
strip. This includes the heart rate associated with any strip in the Selected Strips window and in the printed
report.

The current heart rate is also used to detect tachycardia and bradycardia. The onset of either is determined
to be when the current heart rate reaches the tachycardia or bradycardia settings in the Scanning Criteria
window.

The low and high heart rates reported in the Tables window and in the tables of the printed report refer to
the lowest and highest current heart rate calculated during the interval.

Heart Rate calculation limits

The absolute limits are 20 and 300 (3 seconds to 0.2 seconds). If the “additional dead time” is not set to
zero, then this upper limit can be lowered further. If the “additional dead time” is set to 0.1 or greater, then
the HR upper limit is = 30 / (additional dead time).

Minute-by-minute heart rate

The heart rate plotted in the Trends window is a minute-by-minute heart rate. It is calculated as 60 times
the number of beats processed in the minute divided by the sum of all RR intervals of beats processed in
the minute (in seconds).

Beat-by-beat heart rate

The heart rate associated with each beat in expanded displays whenever the Annotation field in the Prefer-
ences window is set to Heart Rate is the beat-by-beat heart rate. It is calculated based on the RR interval
following the labeled beat. Beat-by-beat heart rate equals 60 divided by RR interval, that is, HR = 60/
(RR).

Mean heart rate in intervals

In the tables (in Tables window and printed report), the mean heart rate within each interval is calculated
by dividing the number of beats in that interval by the amount of time processed within the interval.

Mean heart rate for Holtered period

In the Report Summary (in the Report Summary window and printed report), the mean heart rate during
the Holter test is the number of beats counted divided by the amount of time processed.

Second heart rate

The second heart rate is the heart rate associated with a run of VTAC or SVT. It is calculated as 120
divided by the sum of the current RR interval and the previous RR interval. The second heart rate appears
in strips with VTAC or SVT in Selected Strips, the printed report, and the strip list, labeled HR2.

NorthEast Monitoring, Inc. NEMMO027-Rev-S Page 93 of 99



HE/LX Analysis Operator’s Manual Appendix A - Calculation of Heart Rate

The second heart rate is used to determine where in the ventricular and supraventricular run tables a run of
VTAC or SVT appears. The heart rate separating fast from slow runs is determined by the VTAC and
SVT settings in Scanning Criteria, but the rate of each event is considered to be the second heart rate.

The second heart rate is also used to determine which run is identified as the fastest run of VTAC and
SVT.

AF heart rate

The AF heart rate is used to determine the Fastest AF strip and is also the HR that appears on any AF type
strip created by the software. The AF heart rate is calculated from the average of the RR intervals that are
completely within +- 3.75 seconds of the current beat, which is the same as the standard 7.5 second strip.

Heart rate strips

In the Critical Events window, there is a choice in the Type field called “HR strips.” This displays all ECG
from the Holter test divided into 7.5-second strips. Each strip includes a time-of-day and a Strip HR. That
Strip heart rate is the total number of RR intervals (including partial ones, but excluding artifact) within
the strip divided by the sum of the RR intervals.

Defining dead-time

Dead-time is the amount of time (in seconds) after a detected QRS complex during which the software
will not look for another QRS complex. Generally, this helps to prevent the mis-identification of tall T-
waves as QRS complexes.

The operator can add more time to the tail end of the dead-time using the Extra dead-time setting in the
Scanning Criteria window. Because the recovery time (i.e., the width of the T-wave) varies with heart rate,
the dead-time built into the software adjusts based on the current heart rate. At higher rates, the dead-time
decreases, and at lower rates, the dead-time increases.

The heart rate determines the dead-time as shown in the following table:

TABLE 1. How Heart Rate Determines Dead-time

Heart Dead- Heart Dead- Heart Dead- Heart Dead-
rate time rate time rate time rate time
30-45 0.50000 80 0.23812 115 0.22000 150 0.20000

50 0.43500 85 0.22000 120 0.22000 155  0.19354
55 0.38727 90  0.22000 125 0.22000 160  0.18750
60 0.34750 95 0.22000 130  0.22000 165 0.18181
65 031384 100  0.22000 135 0.22000 170 0.17647
70 0.28500 105 0.22000 140  0.21428 175 0.17142
75  0.26000 110 0.22000 145 0.20689
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Network HASP Key Installation

For Permanent and Timed licenses only.

System Requirements:

1. The network HASP key server should be a minimum of a Windows 7, which is
visible (can be pinged) from each client computer.

2. The network HASP key server must have one USB port available.

3. Port 1947 must be available on all computers for use by the Safenet drivers.

Installation:

1. Install the HASP User Setup on the network license server. During this installa-
tion, the installer will ask for permission to modify the firewall (if any) to allow
network access to the Safenet drivers. This must be allowed.

The current HASP installer is available at www.nemon.com on the Support page
under “Technical Support Files.”

2. Put the HASP key in an available USB port on the server. Using USB hubs is

allowed.

3. On each client computer, install the HE/LX Analysis program, and the Adobe
Reader if prompted to do so. By default the HASPFinder utility will also be
installed.

4. [Install the license.ini file on each client computer.

5. Run the HASPFinder software on each client to verify that the HASP key can be
seen from each location. The HASPFinder should also see the local license.ini
file and confirm that it matches the HASP key.

6. Run the HE/LX Analysis program to confirm installation is successful.
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Setting up Shared Network Patient Data

Beware that this will slow down response time, depending on the speed of your network. If you
choose to set up network patient data, do the following below.

First, determine the location and number of patient directories.

Then, on each client machine, open the h4w.ini file that is located in the c:\nm\bin directory and do
the following:

1. Delete the following lines:

[Current]

LoadedPatient = C:\nm\pat\xx
PatDir = C:\nm\pat\xx
LastPatient = C:\nm\pat\xx

2. Modify the line that immediately follows [PatientParentDir]:
from: c:\nm\pat, xxx
to the network path for the base of the patient directories followed by a comma and the number
of directories that you choose to have created initially.

Next, start the HE/LX Analysis software on a single client machine. It will create the number of
directories you specified on the network machine. (The system may fail as there is no demo patient

yet.)

Lastly, and very important, copy and paste the “demo” patient directory from the client machine to
the patient directory on the network.

PPU Networks - Additional step

In order to count Pay-per-Use (PPU) uses, the program will generate and update a file named
procedure_history.dat in the bin directory.

If HE/LX Analysis is being run on more than one computer, you will need to create an environment
variable called NEM_PROC_HIST. The value of the variable needs to include the a shared network
location that all workstations can access and update.

This is done by going to Control Panel->System->Advanced system settings->Environment Vari-
ables->System variables->New then enter (the variable value is an example):

Variable name: NEM_PROC_HIST

Variable value:
\\server_name\share name\directory name\procedure history.dat

Once the variable is create, re-boot the computer to make it effective. At command line, you can
type “set” and all the settings should show.
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Setting up Shared Network Patient Data

Beware that this will slow down response time, depending on the speed of your network.
If you choose to set up network patient data, do the following below.

First, determine the location and number of patient directories.

Then, on each client machine, open the h4w.ini file that is located in the c:\nm\bin direc-

tory and do the following:

1. Delete the following lines:
[Current]
LoadedPatient = C:\nm\pat\xx
PatDir = C:\nm\pat\xx
LastPatient = C:\nm\pat\xx

2. Modify the line that immediately follows [PatientParentDir]:
from: c:\nm\pat, xxx
to the network path for the base of the patient directories followed by a comma and the
number of directories that you choose to have created initially.

Next, start the HE/LX Analysis software on a single client machine. It will create the num-
ber of directories you specified on the network machine. (The system may fail as there is
no demo patient yet.)

Lastly, and very important, copy and paste the “demo” patient directory from the client
machine to the patient directory on the network.

PPU Networks - Additional step

In order to count Pay-per-Use (PPU) uses, the program will generate and update a file
named procedure history.dat in the bin directory.

If HE/LX Analysis is being run on more than one computer, you will need to create an
environment variable called NEM_PROC_ HIST. The value of the variable needs to
include the a shared network location that all workstations can access and update.

This is done by going to Control Panel->System->Advanced system settings->Environ-
ment Variables->System variables->New then enter (the variable value is an example):

Variable name: NEM_PROC_HIST

Variable value:
\\server_name\share name\directory name\procedure history.dat

Once the variable is create, re-boot the computer to make it effective. At command line,
you can type “set” and all the settings should show.
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Windows 2008 Server Installation

First, each user needs a directory assigned to it in the form of “c:\user\test1” for user test1.
The user name should have no spaces. If there are spaces in the user name, then a logical
redefinition will be required as the HE/LX Analysis program will not accept spaces in the
path of the patient directories.

Then assuming the user names are of the form testxxx, the following has to be done:

1. Make a dummy installation of the HE/LX Analysis onto the C drive in the normal loca-
tion c:\nm. This installation will not actually be used.

2. Copy the license.ini file into the c:\nm\bin directory.

3. Copy and paste the full directory (c:\nm) into each user directory c:\user\testxxxx,
resulting in a bin path of the form c:\user\test1\nm\bin.

4. The file c:\user\test]1\nm\bin\h4w.ini must be edited so that each instance of c:\nm\ is
changed to c:\user\test]\nm\

5. See “Setting up Shared Network Patient Data” to allow for sharing of patient files
Now it should be possible to login to each user with "Remote Desktop Connection" and
have all copies running at the same time up to the limit of licenses in the network key

(dongle).

Once everything is up and running, if the number of users exceeds the number of licenses
allowed, a message "no NEM dongle found" or a "no matching license" will appear.

If the space in user name limitation is a problem, it should be possible to use MKLINK to
create a logical name which is acceptable.

It should be possible to create a script to do all this for each new user.
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APPENDIX C -
TEST ISSUES

The following is a list of test issues that have been identified in this version of the
software:

1.

2.

Lead labels don't translate during install. You will have to create new configura-
tions with the translated lead labels that you desire.
A non-English install may complain that a symbols file is missing, even though it
is not.
Lead labels can be made to be blank, but doing a reanalysis or update may restore
the old label. Just be sure that lead labels are changed to blank before running
report.
The new date on the screens does not change with the operating system date for-
mat. Always dd mmmm, yyyy.
HRV screens are available in non-English languages regardless of time analyzed.
This data is not considered valid if time analyzed is greater than 24 hours.
Patient Info: medications and indications do not trigger new report. If you update
either, be sure to create a new report in order to update.
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